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Continue
Goes to the next domain.    At the end of a page, goes to the beginning of the next page.



Glossary
Click on the items below for an explanation.    If the explanation is too long you will jump out of this screen.
To return to this screen, click on the Back button, , at the top of this window.
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Font Attributes
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Changing Domains
There are several ways to change the current domain on which the user is working:
Continue and Previous Icons
The Domain List Box
The Domain Diagram
The Page Spinner



Edit Words
Puts the user into the Words domain where he or she may select a word by clicking on it, then 
edit it’s font attributes or precisely move it.



Exit
If a Lesn is loaded, exits the current Lesn returning to Start domain. If in Start domain, exits 
Talking Bookmakr to MS Windows.



Font
Select a font and set font attributes, size, color and sound, for the current object, Lesn default, 
Title, Author, or individual Word



Font Color
Set the font color of the current object, Lesn default, Title, Author, Question, Choices or Word.



Lesn
Linear Educational Stimulus Node (pronounced Les' un, the same as lesson), computer-
assisted training.    Talking Books, the first type of Lesns, are targeted at teaching students to 
read.



Font Size
Set the font size of the current object, Lesn default, Title, Author, or Word



Font Style
Set the font style of the current object, Lesn default, Title, Author, or Word



Manual Video Control
Show the Video Controller with the video so the user can control the presentation of the video. 
Manual video control toggles with Automatic video.



New
Make a new current object depending upon the domain, Lesn or Page of the current Lesn.



Previous
Returns to the previous domain.    At the beginning of a page, returns to the beginning of the 
previous page.



Print
Prints the current context: in Page domain, prints the current page on the printer.    In Lesn 
domain, prints all of the pages in the Lesn.    With Talking Book Publisher, users can publish 
Talking Books on their printers.



Icon Bar
Related Topics:

Icon Index
Question Icons

Shows the icons needed in the current domain.    Hold the mouse over an icon for a hint as to its
function.    If more icons are visible than can show in the icon bar, use the Icon Scroll Arrows on 
the left to scroll icons through the icon bar.



Re-align Words
Re-size the windows containing each word so the whole word will be visible, and align the 
bottoms of each word.    Words of different sizes may then require vertical adjustment.



Read Words
Play the word (text, page) sound file and highlight each word as it is spoken.



Record
Start recording sound.



Select Picture
Select a picture with the File Selector Dialog Box.



Select Sound
Select a sound file with the File Selector Dialog Box.



Reading Page
Click on the items below for an explanation.    If the explanation is too long you will jump out of this screen.
To return to this screen, click on the Back button, , at the top of this window.



Select Video
Select a video with the File Selector Dialog Box.



Start Domain
When Talking BookMakr is started up, the system is in Start domain, which means there is NO 
Lesn loaded.    All that can be done from Start Domain is to Create or Load a Lesn, or to Exit 
Talking BookMakr.
Create a new Lesn by
1. Clicking . OR
2 Clicking New Lesn, , from the Icon Bar. OR
3.    Clicking the Next Page button, , in the lower right corner of the screen OR
4.    Clicking File-New from the File Menu.
To Open an Existing Lesn:

1.    Click on File|Open from the File Menu. The Open a Lesn Dialog, (above) appears,
2.    Click on the arrow buttons beneath the objective, to move through the Lesn records 

in the database.,
3.    If the title and objective of the Lesn, indicate the Lesn you wish to load click on the 

OK button    OR
4.    Click on the Cancel Button to cancel without selecting a new Lesn to open.

Exit Talking Bookmakr by clicking Previous button .



View Sound
View (play) the selected Sound File for the current object, Title, Words, a single word.



What Talking BookMakr Does
One of the main reasons that children and non-reading adults don't learn to read is that 

the reading material is not interresting to them.    With Talking BookMakr, users can quickly 
make Talking Books which capture familiar settings, persons, pets and things.    Talking Books 
can teach students to read about things that they already know and love.

With microphones for sound and graphics capture equipment such as scanners, video 
capture cards and frame capture plugs, Talking Books high-interest Talking Books can be made 
with pictures or videos of the home or school, family members, classmates, teachers.    Users fill
in the title and author information on the Title Page:

And the Reading Pages:



By clicking on the "Read Words" icon, , each of the words is highlighted and read out 
loud.    Pictures of familiar things make it easy to associate the picture of the person or thing with
the look of the word on the page and the sound of the word.    Selecting individual words by 
clicking on them pronounces the word aloud or gives a definition, or other information about the 
word.

Soon, most learners can read (and understand) the words themselves.



View Picture
View (display) the selected picture for the current page.    The picture is displayed in a frame.



Stop Recording
Visible only during recording.    Click to halt the recording process.



Select Source of LESN
2.    Select the Drive and Directory in which the LESN resides.

Click on the Next arrow, , at the top of this window.



Registration



Shortcut Key Sequences
Related Topic

How to use Shortcut Keys
Shortcut keys can be used in place of many items in the Main Menu.

Key Sequence Menu Equivalent
F1 Contextual Help
F3 File|New
F4 File|Open
F6 File|Delete
F7 File|Save
F9 File|Play
F10 File|Exit
Ctrl-F3 Page|New
Ctrl-F6 Page|Delete
Ctrl-F9 Page|Play
Ctrl-X Edit|Cut
Ctrl-C Edit|Copy
Ctrl-V Edit|Paste
Ctrl-Del Edit|Delete
RIGHT CLICK Continue



Filling Out The Title Page
Follow the steps below.    Press [Enter] or [TAB] to move to the next object on the Title Page.

1.    Type in a title for the Lesn. The title may have 1 or 2 lines.  Example: My Summer 
Vacation
1a. Select the object for which you will record sound.
1b. Click on the microphone icon 
1c. Wait a moment.    After some record keeping the Stop Recording Icon, , will appear.
1d. Start talking, directly into the Microphone.
1e. Click      quickly when you are through recording.

1f. You may listen to your recording by clicking the View Sound Icon, .    You may re-record the 
sound clip as many times as desired to get the sound exactly the way you want it.
2.    Type in your first name.  Example: Diane
3.    Enter your middle name.    Examples: Lynn or L.
4.    Type your Last name.    Example: Smith
5. Type in the name of the person, organization or company which owns the copyright of the 
Lesn.  Examples: Bob E. Juarez, Interplanetary Bisquit Company.
6.    Type in the City and State, Country of the copyright.  Example: Akron, Ohio, USA
7.    Click on any item on the Title Page to edit it OR
        Press the Next Page button, , to go to the first reading page.



Longer
Increase the sound segment to be played by the number of milliseconds in the increment 
display, and read the sound file segment.    Increases by the largest amount.



Student Feedback First & Second Selections
If the first selection of a student is incorrect, the author may give the student a second 

chance to select.    The second selection has it’s own values for Response, Remediation and 
Next Action.    The feedback to the student’s first selection is indicated by the light gray (leftmost)
bank of colored panels and is set with the light gray, 1st Selection Control Box (below).

The feedback to the student’s second selection is indicated below by the dark gray (left) 
bank of colored panels and is set using the dark gray, 2nd Selection Control Box (below).

Notice in the pictures that the current bank of colored indicators on the right are outlined 
in red, showing both the current response (A, B, C or D) and the current selection (1st or 2nd).    
The corresponding Selection Control is also highlighted in red.

For clarity, we will show only the 1st Selection and the selected response:    the second 
selection and the other responses work in the same way.

Click on the Next arrow, , at the top of this window.



Student Feedback Selecting a Response Box

Questions may have 2 - 4 possible choices.    The picture above has the “A” choice selected and
the picture below has choice “B” selected.

To select the response (and it’s accompanying Choice):
1. Get into Response Domain
2. Click on the Custom Response Text Box (beneath the words “Custom Response”) for 
the response you wish to edit.

Click on the Next arrow, , at the top of this window.



Student Feedback Runtime Interface

At run time, when the LESN is playing, the question page consists of the Picture, Video, 
Selection Indicator, Question, 2 - 4 Choices, the Repeat button and Score Windows.    The 
picture above shows the Custom Response Window beneath the Question Window, while the 
picture below shows the Default Response Window.

The default Responses, “Correct !” and “Incorrect !” are colored green and red respectively.

Click on the Next arrow, , at the top of this window.



Question Page (short)
A Talking BookMakr page which can ask a multiple choice question, evaluate student input, 
respond to the user, remediate in the case of incorrect answers, and then repeat the question or
change the flow of the LESN based on the student's answer. Question Pages can be created by
clicking the Next button in the lower left corner of the last page of the LESN and then clicking 
"Question Page" on the New Page Dialog.



To select the response you wish to edit.
1. Get into response domain by clicking the Continue arrow.
2. Click on the response text box beneath the words "Custom Response" for the response 
you wish to edit.
The selection indicator on the left side of the choices will highlight in the row you clicked.



Next Action
The third and final component of Talking Bookmakr feedback to student selection of a choice is 
called "Next Action", in other words, "What do we do next?".    The possibilities are:
1.  "Go to the Next Page"
2. "Jump to Another Page" and execution of the Lesn will continue from this new page, 
based on the user's selection.
3. "Repeat the Question"    is a possible action for the first selection and only the first 
selection.    "Repeating the Question", asking the question again and accepting another student 
selection, is not available on the second selection, because this may put up a roadblock in the 
LESN which can be frustrating or even irritating to students.



Cancels this box without loadin a new Lesn.



Loads the currently displayed Lesn.    Replaces a Lesn if one is already loaded.



The name of the Author of the currently displayed Lesn.



Returns to the first record in the database of lessons.



The objective of the candidate Lesn.



The title of the candidate Lesn.



Help-Diagram
Shows a diagram of the domains of the Talking BookMakr System.    Place the cursor over the 
domain name to display a short description of the domain.    Clicking on a Domain name when 
“Activate” is checked, activates the domain.    The diagram stays on top of the system until the 
user clicks the “Ok” button.



A list of the directory structure of the current disk drive.



The combination of drive and directory currently selected by the dialog box.



The type (file extension and meaning) of files listed in the File Name List above.



Page Display
Displays the number of the current page.



Pages Display
Displays the total number of Reading Pages which have been created.



Moves to the last record in the database of Lesns.



Returns to the previous record in the Lesn database.



Author
The person who designs, receives credit for writing, or leads the design team of the book.



Talking BookMakr Dialog Boxes
Talking BookMakr uses several dialog boxes to present information to the user, get input from 
the user or both.    Click on the names of Dialog Boxes below for an explanation.    Click the 
[Back] button above to return here.
About Talking BookMakr
Synchro Sound Synchronizer
New Page Dialog
Domain Diagram
Open File
Save File As
Delete Lesn
Open Lesn
Lesn Not Found



Leader
The beginning of a sound file, before the first word or music is spoken or played.    May contain 
background noise from the room in which the sound was recorded.



How to Record Sound
Sound can be recorded for six Talking BookMakr objects: Title, Text,    Word, Question, Choice 
and Response.

1.    Select the object for which you will record sound.
2.    Click on the microphone icon 
3.    Wait a moment.    After some record keeping the Stop Recording Icon, , will appear.
4.    Start talking, directly into the Microphone.
5.    Click      quickly when you are through recording.

You may listen to your recording by clicking the View Sound Icon, .    You may re-record the 
sound clip as many times as desired to get the sound exactly the way you want it.

The Question Page objects, Question, Choice and Response wil display a mark in their 
respective Sound Checkboxes, after a sound file has been recorded or loaded from an existing 
file.



Help Menu



Select Export Target Directory
2.    A dialog box will appear which will allow you to select the drive and directory to which the 
LESN will be exported.    Select the drive by picking a drive (usually drive A) from the drive 
selector box.    Select a directory if you like, and then click on the [OK] button.

Click on the Next arrow, , at the top of this window.



Question - Stimulus
Clicking this menu item brings up the Question (stimulus) domain.    In the Question domain the 
user may set the font characteristics of the the question, type in the text of the question itself, 
and record/select a sound file to embed into the text.



Question Menu
The Question menu can put the user into various domains to control how the question page 
presents and responds to the student.

The author must create a question page for the question icons to appear.

    Click on menu items in the picture to learn what they do.



New Page Dialog
The New Page Dialog is used to create new pages in the LESN.

To make a new page:
1. Go to the last page of the LESN, by clicking the    button.
2. Click    from the last page of the LESN.
3. Set the type of page by clicking on "Reading" for an informational page or "Question" to 
ask a question.
4. Click on the Yes button.
The new page will be created and will appear ready to edit.



How to Change the Background
Related Topic:

Background (examples)
The background of the reading pages of your personal reader can be plain, gradient or tiled.

1.    Change the domain to "Lesn".

2a.    To make a plain background, click on Plain.

2b.    To make put a top-to-bottom, blue-to-black gradient, click on Gradient.

2c.    To make a background from a small picture with the picture placed on the background 
repeatedly like bathroom tiles:    First click on "Wallpaper".

3. The picture file selector will appear:

Select a picture from the list on the left, then click on the OK button.    The reading pages will 
have the background you have selected.



Insert A Diskette
3.    A dialog box will direct you to "place a diskette into the drive".    This dialog box appears in 
case you are making a non-internet, floppy-diskette, LESN export. Skip over the box, by clicking
on [OK].

Click on the Next arrow, , at the top of this window.



Edit Text
Edit the text of the current page.    If any individual words have been created from the text, they 
will be deleted.



Edit Menu Commands
Use the scroll bar to see more commands.
Copy
Copies the text of the current Help topic to the Clipboard.
From the Clipboard, you can paste the text into another application or document.
Annotate
Adds text to the current Help topic.
Annotations are marked with a paper-clip icon, which appears in front of the topic heading.



Help-Tutorial 
Live action tutorials of all Talking BookMakr functions.    Tutorials are purchased separately and 
may be ordered on the Edutronics Web Page, or by mail.



Main Menu
Related Topic:

Question Menu
Menu selections in the Help System are indicated like this:    File|Exit which means click 

on the "File" menu in the main menu and then click on the "Exit" item on the "File" menu.
Click on Menu Items in this picture to learn what they do    OR
Click the Next arrow at the top of this screen to browse through the menus.

To make Talking BookMakr easier to learn and use, Edutronics has made the Main Menu
of Talking BookMakr context-sensitive.    Only valid menu items for the current domain are 
visible.    For instance, in Text domain (above), the Text and Edit Menus are visible, but they are 
not visible in the Start domain because there is no Lesn loaded, hence no Text to edit.

Each domain shows only valid Menus and Menu items within each menu.

Question Menu 
With the advent of version 1.2 of Talking Bookmakr, there is now a sophisticated multiple choice 
Question menu.



Open A Lesn Dialog Box
Lesns are selected from Lesns which exist on the system. (Click on items above for an 
explanation.)
To Open an Existing Lesn:

1.    Click on File|Open from the File Menu. The Open a Lesn Dialog, (above) appears,
2.    Click on the arrow buttons beneath the objective, to move through the Lesn records 

in the database.,
3.    If the title and objective of the Lesn, indicate the Lesn you wish to load click on the 

OK button    OR
4.    Click on the Cancel Button to cancel without selecting a new Lesn to open.



File-Open
Open an existing Talking Book by selecting the title of the book from a list of Talking Books.



File-New
Create a new Talking Book structure, which can then be filled in by the author.



Synchro Word-Sound Synchronization Tool
See Also:

How to Use Synchro

Click on parts of the Synchronization Tool above for explanations of their functions



Increase Increment
Increases the size of the increment.    If the size of the increment is increased from 60 to 100.    
Then each time the Longer or Shorter buttons are clicked, the sound file segment will be 
lengthened or shortened by 100 milliseconds instead of 60 milliseconds.    Increasing the size of 
the increment at first can help you get to the correct length of sound segment with fewer clicks.



Save As Dialog Box

The Save As Dialog can be used to:
1. See the complete path of the current file.
2. Make a copy of the current file with a new name.
3. Make a copy of the cureent file in a new drive and/or directory.

To save a file with the Save As dialog:
1. Select the drive where the file will be saved by clicking on it in the Drives combo box.
2. Select the directory where the file will be saved by clicking on it in the Directories scroll 
box.
3. Click on the File Name, and change it to the desired file name.
4. Click the Ok button to save the file.    Or

Click the Cancel button to exit without saving the file.



Automatic Video
Set the video to play automatically when the user clicks the View Video icon. The video then 
plays straight through without user control.



About Talking BookMakr Dialog Box
The About Dialog Box shows Talking BookMakr copyright information, as well as how to get in 
touch with us at Edutronics Ltd.    Click on the picture in the upper left (in Talking BookMakr, not 
this Help system) corner for information about the resources available on your computer.



Delete Lesn Dialog Box

To Delete a Lesn from your system:
1.    Click File|Delete from the Main Menu. The Delete a Lesn Dialog (above) will appear.
2.    To Delete the Personal Reader from your system, click on [Ok] OR
3.    To cancel without deleting the Lesn, click on [Cancel].



Help-About
Displays program information and various ways to contact Edutronics Corporation.



Font Display
Click on parts of the picture to identify the parts of the Font Display.
The Font Window displays the name of the font of the current object, Title, Author, Lesn, Page, 
Question, Choice or individual word.



Font Window
The Font Window displays the name of the font of the current object, Title, Author, Lesn, Page 
or individual word.    The word might be "Arial" or "Thunder Bay".    It will be in the style (bold, 
italics, underline) and the color of the font of the current object.    The size of the font is 
displayed in the Font Size Window immediately below and to the right of the Font Window.



Status Bar
Displays prompts of what to do next.



Repeat Question 
A presentation of the question and choices.    Repeating is done automatically if a lesson 

is playing, or may be done again by clicking the "Repeat" button.    The repeat process displays 
the question, then reads it's sound file, then repeats each choice and reads it's embedded 
sound file.



How To Set Font Attributes
There are four attributes to Talking Bookmakr Fonts.    Font attributes are displayed in the 
control panel for the current domain.
 Click on an attribute below to have it pop up    OR

Move through the attributes full screen by clicking on the Next and Previous buttons at 
the top of the screen.
Font name
Font size
Font color
Font style



Brings up Help about the Open a Lesn dialog.



The number of pages in the currently displayed Lesn.



Workspace
A workspace is the directory into which the LESN files (pictures, sounds and videos) are 

stored.



Question Page Domain
A Talking BookMakr page which can ask a multiple choice question, evaluate student input, 
respond to the user, remediate in the case of incorrect answers, and then repeat the question or
change the flow of the LESN based on the student's answer.
To Create a Question Page click the Next button in the lower left corner of the last page of the 
LESN and then clicking "Question Page" on the New Page Dialog.



Author Middle
The middle name or initial of the author.



Page Menu



Main Screen

Click on items on the Main Screen picture above to identify them.    The Main Screen is the 
starting point for creating a Talking Book.    Two other windows come up inside the Main Screen:
The Title Page and numbered Reading Pages.    Select items from the white Main Menu or icons
from the Icon Bar to control the program.    When a Lesn is opened, the name of the Lesn is 
displayed in the Title Bar.



Continue
Continue means go to the next suggested domain.    There are several ways to Continue:
1) Click the right mouse button anywhere on the background of the Page or 
2) Press      key  or 
3) Press      key  or 
4) Click the green Continue Icon, , on the Icon Bar  or
5) Click on the subject of the next domain item.



LESN
Linked Eductional Stimulus Node (LESN).    A computer-delivered lesson (Lesn) which is a node 
from a web of inter-related lessons.
Each Lesn can be played alone only for its own content.    Taking all Lesns as a group (or 
curriculum, or web), however, each Lesn (L1, L2, etc. in the diagram) is a node on the Lesn 
Web:
    
Each learner will take different zig-zag paths through the lesson nodes of the web according to 
individual interests and needs.
There will be varying types of lesns.    The first type of Lesns are Personal Readers.    These 
talking books can help people to learn to read.    Following will be spelling, math, and other 
types.of Lesns.    Users may make Lesns and may distribute or sell their Lesns to others.    
Contact Edutronics on the Edutronics Web Page on the World Wide Web at    
WWW.Edutronics.Com.    See the Help-About Box for information on how to contact Edutronics.



Exporting a LESN
Exporting a LESN from your system copies the database files of the 

LESN, compresses the LESN database and media asset files to a single file in a target directory
that you select, and spans the file over as many disks as are required to accommodate the 
LESN.

This is the procedure to export a LESN to be spanned over a set of diskettes.
After examining each step of the process, click on the Next arrow, , at the top of this 

window.
1.    From the File menu, click on "Export To Disk'

Click on the Next arrow, , at the top of this window.



Analytical Eduction (short)
The process of measuring how the learner learns (what interests, proclivities, academic 
strenghths and deficits each learner has), how a lesn teaches (visually, auditorily, by 
manipulation, with reading, pictures analogies, colors) cataloging instructional materials and 
matching the learner with instruction which will be most likely to be most effective and 
interesting for each learner.



The Big Picture
Most Lesns are targeted pieces of instruction that just explain or teach 1 thing.    These Lesns 
can then be mixed and matched to make complete instructional productions which we normally 
call "lessons" or "Computer-Based Trainging" (CBT).

Our present thinking is to provide a somewhat open system containing:
1. A group of easy-to-use authoring systems, such as Talking BookMakr, which can be 
used to produce targeted components of Computer-Based Training (the LESNs).
2. A Lesn cataloging and launching system.    With this system learners will be able to 
manage their Lesns, import, and organize them into interrelated Lesn webs which we usually 
call lessons.
3. A recorder to record the interactions between the lesn and the student.
4. A reporter to issue reports of student work.
5. An analytical module which will produce both a Lesn profile and a learner profile.    The 
Lesn profile will summarize how the Lesn teaches, the learner profile will summarize how the 
student learns.
6. A component marker by which educators can make ratings scales and attach markers 
for a specific scale to pages of a Lesn, Lesns or groups of Lesns.
7. An Analytical Education applet which can measure what is most likely to teach most 
effectively and in the most interresting way to each learner, and then prescribe that instruction.
8. A Lesn Consortium where persons can download public domain lesns with which to 
learn, or organize lesns into new instructional webs.
9. An internet runtime, to run the Lesns in real time over the internet.    In this way students 
need not wait to download Lesns, they can learn from a Lesn without it ever residing on their 
local computer.

We then wish to take what we learn from each step of the process and produce "Level II" 
versions of each of the above products and services.    This process should approach our goal 
of making learning free, universally available, accessable at any time of the day or night, much 
more effective and much more interresting (even fun?).



Paste
To insert the contents of the MS-Windows clipboard into the text window at the location of the 
cursor (the insertion point).



Copy
Make a copy of the highlighted text and, while leaving the original text in the Text Window, 
transfer the copy of the text to the windows clipboard.



Cut
Transfer highlighted text to the MS-Windows clipboard.



How to Edit Text
To Select Text:
1.    Click at the front of the text to be selected.
2.    Hold down the left mouse button and drag the cursor forward until the desired text is 
highlighted OR
3.    Hold down the [Shift] key while moving the cursor forward witht he right arrow key until the 
desired text is highlighted OR
4.    Click on Edit|Select All to highlight all of the text.

To Cut Out Text
1.    Select the desired text
2.    Click on Edit|Cut, OR
3.    While holding down the      key, press the [X} key.

To Copy Text
1.    Select the desired text
2.    Click on Edit|Copy, OR
3.    While holding down the      key, press the [C} key.

To Paste Text
1.    Click on the place in the Text Box that you wish to insert the contents of the clipboard.
2.    Click on Edit|Past, OR
3.    While holding down the    key, press the [V} key.



Open File Dialog Box

To Open a File:
1.    Click on File|Open from the Main Menu,
2.    To Change Drives: Click on the down arrow to pull down the list of Drives in the Drives 
Combo Box, and double click the desired drive    OR
3.    When the desired Drive is selected, To Change Directories: Click on the down arrow to pull 
down the list of Directories in the Directories Combo Box, and double click the desired directory  
OR
4.    When the desired Directory is selected, To select the file to open, click on the name of the 
file and press [Enter]    OR
5.    Scroll down the file list to the desired file name, and double click it    OR
6.    Select the file name and then press the [Ok] button    OR
7.    Clilck the [Cancel] button to Cancel without selecting a file.



Objective Domain
The Objective Domain deals with the objective of the Lesn.
Select Objective Domain by clicking on . and    while on the title page, until the Domain window
contains "Objective".
Create the text of the objective by typing it into the selected Objective box.
Record objective sound by including it in the Title sound when in Title Domain.    The Title 
Sound might by "'The Farm', by Mary Smith.    The objective of the lesn is to learn to read the 
names of seven different farm animals.
Move to the Title Domain by clicking on the title or pressing the    key.
Move to Page 1 by clicking on .



Question Domain
The Question Domain deals what most users refer to as the question, more acccurately referred
to as the stimulus.(We at Edutronics refer the the entire object, stimulus, choices, and 
responses, as the Question).
Select Question Domain by clicking on the  while in a question page.
Create the text of the question by typing it into the selected Question box.
Change font characteristics of stimulus by clicking the font attribute buttons, , . ,    .
Record stimulus sound - by clicking , recording a sound file with the microphone, and then 
clicking .
Move to the first choice by clicking on it or pressing the    key or by clicking on .



Choices Domain
In the Choicea domain the user may set attributes which affect all choices in the Question.
Switch to Choices domain by clicking on . and    while on a question page, until the Domain 
window contains "Choices".
Select the number of choices by clicking the up and down arrows of the Choice Number 
Spinner (2-4).
Change font characteristics of all choices and enumerators by clicking the font attribute 
buttons, , . ,    .
Move to Choice Domain by clicking on .



Choice Domain
In the Choice domain the user may type in the text of any choice, embed a sound file into the 
choice, Fix the location of any choice to a given slot in the presentation sequence.
Switch to Choice domain from a question page by clicking on . and , until the Domain window 
contains, "Choice".
Select the desired choice by clicking on it.
Make text of the choice by typing it into the choice box.
Fix the location of a choice by clicking on the Fixed Location Checkbox next to the 
ennumerator.    If not fixed, choices will move randomly to different ennumerators, different times
the Question page is run.    The choice, "None of the Above", should be the last choice.    
Clicking fix location will assure that a choice always appears next to the same enumerator, "A", 
"B", "C" or "D"..
Record sound for the choice - By clicking , recording a sound file with the microphone, and 
then clicking .
Move to the next choice by clicking on it or pressing the    key.



Response Domain
To get into response domain from a question page click the continue arrow until the domain 
window contains "Response".
To select the response to edit click on the response text box beneath the words "Custom 
Response".    The selection indicator on the left side of the choices will highlight in the row you 
clicked.
Custom response - type the custom response into the response window.
Record sound for custom response - click , talk, and press    when done, click.. 
Set Response, Remediation, and Next action by clicking the radio buttons in the Response 
controller.



 Question Icon
Make a stimulus portion of a multiple-choice question. Type in the text of the question, set the 
font attributes of the question, record or select a sound file to embed with the text.



Author First
The author’s first name



Font Attributes
The font name (Arial, Times New Roman, etc.), color, style (bold, Italics, underlined or normal) 
and size (8 point, 10 point, 50 point) are attributes of the font.



Help on Performing Talking BookMakr Procedures
Talking BookMakr Help is organized under four main headings: Concepts, Procedures, 
Reference, Help on Finding help.
To become familiar with Talking BookMakr procedures
1    From the Help Button Bar, select Contents.
2    Click on the underlined word Procedures.
3    Make a selection by clicking on an appropriate topic
4    Click on the << and >> buttons to browse through the Talking BookMakr Procedures 
sequence.
To get help on a specific procedure
1    From the Help button bar, select Search
2    Type in the concept you wish to find help on.
3    Click on Goto for help on the procedure



Exiting Help
When you exit Talking BookMakr Help you may leave the help window up or close it.
To completely exit Help
Click on Exit in the Help button bar
To return to Talking BookMakr and leave the Help window on the screen
1    Drag the edge of the Help window to make it small enough to see the Talking BookMakr 
Main Screen.
2    Click on Help in the Help menu bar
3    Click on Always On Top.
4    Drag the Help title bar so that the Help window is not covering the part of the Main Screen 
you want to return to.
5..Click on the area of the Main Screen which you want to return to.
        Or click on File in the Help menu bar, and select Exit



Help Button Bar
Contains the help buttons you can use to move to topics. It is located near the top of the Help 
window.



Shorter
Decrease the sound segment to be played by one quarter of the number of milliseconds in the 
increment display, and read the sound file segment.    Decreases by a medium amount.



Page-New
Adds a new page to the current Lesn (Lesson).



Score Display Checkbox
 If checked at design time by the author, the Lesn will display the number of the question and 
the percentage correct to the student at runtime.    If not checked, the question and score will not
be visible to the learner when the LESN is played.



Objective Window

The objective window presents the objective of the LESN - the behavior that the student should 
be able to accomplish at the end of the LESN.    The Title Sound can be used to read the Title of 
the LESN, the author's name and the objective, if so desired by the author.



Custom Response Window
Related Topics:

Default Response Window
Custom Response

The Custom Response window appears at runtime when a custom response has been 
attached to the choice selected by the student.    The custom response presents one to a few 
lines of text to respond to the selection of the attached choice by the student.    While the text of 
the custom response is displayed (as above), the custom text sound is played to the student.



Default Response Window
Related Topics:

Custom Response Window
Default Response

The default response window appears at runtime, as the LESN is playing.    The default 
messages are "Correct !" and "Incorrect !" with embedded sound which reads the text aloud.    
Default text can be used to quickly produce a Lesn.



Default Response
Talking BookMakr can provide "correctness responses" to the user.    If "Default 

Response" is selected for a choice, a response in text and sound of "Correct" or "Incorrect" will 
be shown and read to the student if the choice is picked.



Text Menu



Words Menu



Finding Reference Material
Talking BookMakr Help is organized under four main headings: Concepts, Procedures, 
Reference, Help on Finding help.

To see the main groups of reference material
1    From the Help Button Bar, select Contents.
2    Click on the underlined word Reference.
3    Make a selection by clicking on an appropriate reference topic
4    Click on the << and >> buttons to browse through the Talking BookMakr Reference 
sequence.
To get help on a specific topic
1    From the Help button bar, select Search
2    Type in the topic you wish to find help on.
3    Click on Goto for specific help.



Copyright Holder
The owner of an intellectual property such as a Personal Reader.



Copyright Year
The year, according to the system clock, that the Lesn was begun.



Copyright Location
The city plus the state/province/district and the country.



Copyright
The legal owner of a piece of intellectual property, like a Personal Reader, is said to own the 
copyright on the property.



Talking Bookmakr Tutorial
The Talking BookMakr tutorial will show you how to make a reading LESN.

Navigating the Tutorial
    To move from one frame of the tutorial to the next, click on the    button in the button bar.    
Click on the    button to return to the previous frame.    When the > > signs in the button are 
emphasized, they are active.    When you reach the end (or the beginning) of the tutorial the 
button will be de-emphasized.    These arrows    are both emphasized.    The foreward arrow here
is emphasized and the backward arrow is de-emphasized.

    Now click the    arrow to start the tutorial.



Limit (to number of words per page)
Versions at least through 1.1 and below have a limit of 150 words per page.    But there is no 
limit to the number of pages per Talking Book.



File-Export To Disk
Copy a Personal Reader you have made, to a diskette or other directory for sending over the 
internet.



File-Import From Disk
Import a file from a diskette or other medium to your Personal Reader System.



Lesn Not Found Dialog
The Lesn Not Found Dialog may appear if the user attempts to Open or Delete a Lesn which 
has been erased using another program such as Windows File Manager or DOS Erase 
command.    The dialog may also appear if a Lesn was partially erased due to a computer or 
other error in the system.



Question - Choices
Clicking this menu item switches to the Choices domain.    In the Choices domain the user may 
set the font characteristics of all of the choices and select the number of choices (2 - 4 choices 
are permitted).



Question - Response
Clicking this menu item switches to the Response domain.    In the Response domain the user 
may set the Response, Remediation and next action for each choice.    Custom text and sounds,
default text and sounds or a combination may be set to respond, to any choice selected by the 
user.



Question - Choice
Clicking this menu item switches to the Choice domain.    In the Choice domain the user may 
type in the text of any choice, embed a sound file into the choice, Fix the location of any choice 
to a given slot in the presentation sequence. Select the desired choice by clicking on it.    Go to 
the next Choice by pressing the [Tab] key.



User
The person using the software.    There are two types of users: One who uses Talking BookMakr
to create a Talking Book is called the Author.    Another type of user, the Learner, reads the 
Talking Book created by the author.



Text



User Support



Text Sound File
Each page of talking BookMakr may have a Text or Page sound file.    When the words are read 
aloud, this sound file is played as the words being pronounced are hilighted.



Synchro (short)
The controller used to synchronize the highlighting of the words with their pronunciation.



Text Editor
The blue version of the Text Window does not contain a full-featured word processor, but it does
have a functional Text Editor which can cut, copy, and paste text to and from the Windows 
Clipboard and as well as load and save ASCII text files.    Authors type the text into the blue 
window, the text is divided up into Words.    Each word is a separate object which can be edited 
separately.



Talking BookMakr
An MS-Windows program with which users can quickly and easily make high interest Talking 
Books about their families or other subjects.    Talking Books are a type of Lesn, which tell a 
story with a sequence of pictures and/or videos accompanied by explanatory words which 
pronounce and change color when they are clicked.    The entire text can be read by clicking the 
Read Words button.    Talking Books can help learners learn to read in ways that other reading 
materials may not.



Talking BookMakr (detailed)
Talking BookMakr is an MS-Windows application with which users can quickly and easily make 
Talking Books about their families or other subjects.    Talking Books are a type of Lesn, which 
tell a story with a sequence of pictures and/or videos accompanied by explanatory words which 
can pronounce themselves when they are clicked.    The words are highlighted as they are 
pronounced.    The entire text can be read by clicking the Read Words    button.    Talking Books 
can help young people learn to read in ways that other reading materials may not:

1.    Children may participate in making the Talking Book themselves, giving them emotional 
ownership,

2.    Naturally high interest of using familiar people, objects, pets and settings: such as family 
members, teachers and classmates, pets, classrooms, toys and learning materials in the Talking
Books,

3.    The ability to click on each word to relate the sound of the word to its appearance and 
spelling.

Edutronics can put Talking Books onto CD's which can be run on any MS-Windows computer 
with a CD player.



How To...
General

Navigate Through Talking BookMakr
Set Font Attributes
Open a File
Record Sound
Change the Background of Reading Pages

Lesn
Create a New Lesn
Open An Existing Lesn
Make A Personal Reader
Play Your Personal Reader Lesn
Export a LESN from Talking BookMakr
Exoport a LESN over the Internet
Import a LESN into Talking BookMakr
Importing a LESN Sent Over the Internet

Text
Edit Text
Use The Text Editor
Break Text Into Words

Words
Create Words
Edit Words
Highlight Multi-Word Groups
Synchronize Reading Text and Words

Question
Create a Question Page
Create a Question
Record Sounds
Set Parameters for all Choices
Create a Choice
Make a Response
Test The Question



Edutronics Group Box
The Edutronics Group Box Contains icons from your installed Edutronics programs.    May 
contain icons for Talking BookMakr,    Talking Book Runtime or Talking Book Publisher    



Talking Book



Lesn Directory



Help-Search
Displays the MS-Windows search engine used to find topical infomation.



Help-Contents 
Displays the Contents page of the Talking BookMakr Windows Help system.



Alignment
After the original Text entered by the author is divided into separate words, each word is viewed 
through an invisible word window.    Changing a word's size and style can make the word 
window too large or too small for the text inside.    Alignment resizes all text windows to the 
exact size of the text they contain and lines up the bottom of each word.    Words may require 
additional alignment to account for the descending parts of some letters such as "j" and "g".



.WAV
The default file extension of MS-Windows sound files.



.BMP
The file extension of a bitmapped graphics file: a format for storing a picture.



.AVI
Stands for Audio/Video Interleaved -- the file extension of MS Video for Windows movies.



Text Editor (detailed)
The Text Editor is a light blue (cyan) box.

The text editor gets its original font attributes from the font attributes of the Lesn at the time the 
text is first entered.    The Text editor is where authors enter the original text for the page.    The 
Text Editor should not be confused with the Words Editor, 

which is the same size and shape, but is white in color.    The individual words in the words 
editor are made up automatically from the text in the text editor when the user exits the text 
editor.

The Text Editor can cut, copy and paste text, as well as load and save simple ASCII files which 
normally have the extension ".txt" .

How to Open a Text File
1.    Click on Text|Open from the Main Menu.        The Open File Dialog Box appears,
2.    To Change Drives: Click on the down arrow to pull down the list of Drives in the Drives 
Combo Box, and double click the desired drive    OR
3.    When the desired Drive is selected, To Change Directories: Click on the down arrow to pull 
down the list of Directories in the Directories Combo Box, and double click the desired directory  
OR
4.    When the desired Directory is selected, To select the file to open, click on the name of the 
file and press [Enter]    OR
5.    Scroll down the file list to the desired file name, and double click it    OR
6.    Select the file name and then press the [Ok] button    OR
7.    Clilck the [Cancel] button to Cancel without selecting a file.

How to Save a Text File
Click Text|Save.    

How to Save a Text File to a New Path
1.    Click on Text|Save As from the Main Menu.        The Save File Dialog Box appears,
2.    To Change Drives: Click on the down arrow to pull down the list of Drives in the Drives 
Combo Box, and double click the desired drive    OR
3.    When the desired Drive is selected, to change directories: Click on the down arrow to pull 
down the list of Directories in the Directories Combo Box, and double click the desired directory  
OR
4.    When the desired Directory is selected, To select the name of the file to be saved, type a file
name into the file edit box and press [Enter]    OR
5.    Clilck the [Cancel] button to Cancel without saving a text file.



Talking BookMakr Screens
When Talking Bookmakr starts up, the    Main Screen becomes visible.    When a new Talking 
Book Lesn is started or an existing Talking Book is opened, the Title Page appears.    The Title 
Page contains default information (Title, Author, Copyright) when a new Talking Book is created,
and edited information that the author has entered in a previously existing Lesn.    Talking Books
contain an unlimited series of numbered Reading Pages which display a picture and/or video, 
text describing the picture or video and the ability to read the text aloud, highlighting each word 
as it is spoken.

Talking BookMakr now also has interactive Question Pages.



Student Feedback Making the Next Action

The Next Action component of the student feedback determines what happens next.    
We have had the opportunity to respond to the student’s choice, remediate if incorrect, and now 
we must either repeat the question or go on.    We may continue with the LESN in its normal 
sequence or we may jump to any frame which exists in the LESN in concert with what we have 
just learned about the student’s understanding as indicated by his or her choice selection.

If the student has just indicated that he or she has missed (or mastered) a fact or a skill 
we may jump forward or backward anywhere in the lesn to skip unneeded material, review 
previous material or take a parallel path and explain the material in a different way.

To Go To the Next Page
This is the normal next step after a question and selection.
1. Click on the response text box you wish to edit.
2. Click on “Next page” in the Next Action group box of the appropriate Selection Control.

To Jump to Any Other Page
1. Click on the response text box you wish to edit.
2. Click on “Jump to pg __” in the Next Action group box of the appropriate Selection 

Control.
3. A spinner will appear.    Click the up and down arrows on the spinner to get the number 

of the desired jump page in the box.
4. Click off of the spinner to make it go away.

A Jump changes the flow of the LESN.    After the jump is made, say from page 7 to page
50, the lesson will continue playing from page 50.    It’s next page will be page 51, 52 and so on 
until another jump is executed.

To Repeat the Question
You may only repeat the question on the first selection, otherwise student’s may get into a 
roadblock and be unable to complete the LESN.
1. Click on the response text box you wish to edit.
2. Click on “Repeat questn” to repeat the question at run time.

Click on the Next arrow, , at the top of this window.



Backtracking Through Help Topics
Use the Back button to got back through the Help topics you have viewed, in the order in which 
you viewed them.    If there is no previous topic to view, the Back button is dimmed.    The record
of topics you have viewed is removed each time you quit Help.
To backtrack through Help Topics
Choose the Back button on the Help button bar.
Or type b.
You return to the previously viewed topic.    The topic appears as you left it, unless you resized 
the window before backtracking.
Related Topic
Moving Around in Help



Words-Sound 
Puts Talking BookMakr into Words Domain, where user may record a sound file explaining each
individual word.    Words Sound is a professional feature which is only available in Talking 
BookMakr Pro.



Click here to cancel the file save operation.



Click here to confirm the file name and folder to which to save.



Click here to select from all of the local and network drives available.



File-Save
The contents of the current Talking Book are automatically saved when exiiting BookMakr, when
another Lesn is loaded, or when returning to Start domain. Users may save the Talking Book at 
any time to ensure that changes are saved in the event of erratic computer performance.



RunTime
Run time is when the Talking Book Lesn is being played by a Learner or by an author testing the
Lesn.    A program which can run Talking Books as stand-alone Lesns (without the presence of 
Talking BookMaker) is called a Run Time module.
Run time is the opposite of Design Time, the time when the Lesn is being constructed and 
tested.



Selection (of a choice)
The process of picking a choice from a multiple choice question, is called selection.    

The selection is made by clicking on the correct choice or on the enumerator of the correct 
choice.    If the question is set up properly, the student may make a second selection if the first 
selection is incorrect.



 Back Button
Returns to the previous page.    Exits Talking BookMakr if on Page 0, the Title Page.



Page Up Button
Click to go on to the next page.    Asks permission to create new page if it does not exist.



Test The Question
After creating a Question, Choices, and Responses, LESN authors may wish to test the 
interaction of the question to verify that it performs as expected.

To Test the Question
1. Turn to the desired page of the LESN by clicking the Next, , and Back, , buttons.
2. Use the continue icon, , or alternate means, to get to the Question Page domain.    The 
Domain window should look like this:
3. Click the Repeat button.    The Question and choices should present themselves 
sequencially and normally.
4. Select each choice.    The sequence of events in the Question feedback should respond 
as expected.    One or more of the choices, when behaving as expected, may end by taking the 
LESN to another page, either by the Next Page action or the Jump To Page action.    If you have
not yet been through each choice of the question page, return to the Question Page with steps 1
and 2 above, until you have been through each choice.



Dividing Text Into Separate Words
Type Text into the light blue (cyan) Text Editor.

The Text is automatically divided into individual words, when you leave the Text Editor.    When 
the text is as desired, Continue by clicking the Right mouse button or by clicking the    Continue 
Button.    The white Words Editor will appear with the same words but separated into separate 
objects

The individual words in the Words Editor are made up automatically from the text in the text 
editor when the user exits the text editor.



Author Last
The last name of the author.



 Choices Icon
All choices within a single choice have common font attributes.    Clicking this icon puts the user 
into Choices domain, form where the choice fonts may be set.    The user may also set the 
number of possible choices, with the minimum number being 2 and the maximum number of 
choices being 4.



Using the Glossary
You can find definitions for most words unique to Talking BookMakr (and for words to which 
Talking BookMakr assigns special meanings) by using the Glossary button in the Help window.   
The Glossary button opens the Glossary list, where you select a word that you want defined.
To see the definition of any word in the glossary, just click on it.    If the word is underlined with a 
dotted line, a definition will pop up, if the word is underlined with a solid line, Help will jump to 
the definition.    After you are through viewing the definition, return to the glossary by clicking on 
the Back button in the Help Button bar.
To search for Help information
1 In the Help button bar, choose the Glossary button.

Or type g.
2. Select the word you want defined.
3. The definition will appear.
4. If the definition is a jump rather than a popup, click on the Back button on the Button Bar 
(or the Glossary button) to return to the Glossary.
Related Topic
Moving Around in Help



Leaving Help On Top As You Make Your Lesn
When you use Help, you may want to re-size the help window and leave it on top of the Talking 
BookMakr Main Screen while you work.    This way you can see the screen while you are 
viewing Help.    You can click on the Help window and then the Main Screen as you progress 
through a procedure.    Reading a step in Help, following the instructions in the Main Screen or a
dialog box, scrolling Help down, an reading the next step.
To keep the Help Window on top of the Talking BookMakr Main Screen
From the Help menu in the Help window, choose Always On Top.
A check mark appears next to the command, and a shadow appears around the window border 
to indicate that the Help window is on top.
To change the size of the Help Window
Drag the corner or border of the window until the window is the size you want.
Or press ALT, SPACEBAR to open the Control Menu and use the Size command to change the 
size of the window.
To move the Help Window
Drag the title bar of the window to the new location.
Or press ALT, SPACEBAR to open the control menu and sue the Move command to move the 
window.
See your Windows documentation for more information on moving or re-sizing windows.



 Response Icon
Puts Talking BookMakr into Response domain, where one can set the three components of 
student feedback which are: Response, Remediation and Next Action.    The responses may 
consist of text and/or sound, may be default or custom made and can be attached to each 
choice individually.



 Question Page Icon
Puts Talking BookMakr into Question Page (QPage) domain, where authors can test the 
question and make sure that it behaves as expected.



 Choice Icon
Each choice provided to the student may has a text portion and an optional sound portion.    
Clicking the Choice icon puts Talking Bookmakr into Choice domain.    From here the author 
may set the text, embed the sound, assign a value to, and fix the sequence of, a choice.
Once in Choice domain, the author may move between the choices with mouse clicks and the 
[Tab] key.



Opening (text or media file)
Four types of files are opened with the Open File Dialog Box: Sound files (_.bmp), Videos 
(_.avi), Pictures (_.bmp), text files (_.txt).    
1.    Click on the activator:

Select Picture
Select Sound
Select Video

Text|Open Select Text File
The Open File Dialog Box will appear.
2.    Select the drive from the Drive combo box.
3.    Select the directory on the drive by double-clicking the desired directory in the directory list 
box.
4.    Select the file you want by double-clicking it in the File list box.    The name will appear in the
file Text box.
5.    Click the [OK] button to load the file OR 
          Click the {Cancel} button to cancel the Open File procedure.



Scroll Bar
A bar that appears at the right and/or bottom of a window or list box whose contents are not 
completely visible.    Each scroll bar contains two scroll arrows and a scroll box, which enable 
you to scroll through the contents of the window or list box.



Getting Help from Talking BookMakr
You can get Help while using an application by choosing a command from Talking BookMakr's 
Help menu (when it is visible) or by pressing F1.    Talking BookMakr knows what your current 
activity is, and can usually give context sensitive help relating to your specific activity.



Copying A Help Topic To the Clipboard
You can copy some or all of the text in a Help topic onto the Clipboard. From the Clipboard, you 
can paste the text into another document.
Note: you cannot copy the graphics in a Help topic onto the Clipboard.

To copy text in the current Help topic onto the Clipboard
1    From the Edit menu in Help, choose Copy.
2    To copy all the text onto the Clipboard, choose the Copy button.
You can paste the text that is on the Clipboard into a Help annotation or into a document from 
another application.
To copy the entire topic directly onto the Clipboard

Press CTRL+INS

Related Topic
Annotating a Help Topic



Moving Around in Help
You can use the Help button bar to move around in Help.    You can browse through topics, and 
go back to topics you have viewed previously.    You can search for specific information or 
display Help Content.    You can also choose a jump to go to a new Help topic.
For more information about moving around in Help, choose one of the following tasks:
Backtracking Through Help Topics
Browsing Through Help Topics
Choosing a Jump
Displaying Help Contents
Returning to a Help Topic You Have Viewed
Scrolling Through a Help Topic
Searching for A Help Topic



Removing an Annotation
If you no longer need your comments about a Help topic, you can remove the annotation.
To Remove an annotation
1    Click the paper-clip icon to the left of the topic title.
        Or press TAB to select the paper-clip icon, and then press ENTER.
2    Choose the Delete button.



Annotating a Help Topic
You can add your own personal notes and observations to a Talking BookMakr Help topic.    
When you annotate a Help topic, Talking BookMakr Help places a paper-clip icon to the left of 
the topic title to remind you that you have added a note to this topic.    For help on annotating 
Help topics, choose one of the following tasks.
Adding Text to a Help Topic
Removing an Annotation
Viewing an Annotation



Browsing Through Help Sequences
If the browse buttons (<< and >>) appear in the Help window, it means certain Help topics have 
been grouped together in a sequence.
To view the next topic in the browse sequence
Choose the >> button on the Help button bar.
Or press the period (.) key.
When you reach the last topic in the sequence, or if there is no browse sequence, the >> button 
is dimmed.

To view the previous topic in the browse sequence
Choose the << button on the Help button bar.
Or press the comma (,) key.
When you reach the first topic in the sequence, or if there is no browse sequence, the << button
is dimmed.

Related Topic
Moving Around in Help



Successful LESN Import
Related Topic:

Exporting a LESN
Importing a LESN From Over The Internet

4.    If the import is successful, the LESN you loaded will be integrated in with the LESNs created
on your system and loaded as the current LESN.

This is the last frame of "How to import a LESN".



Choosing a Jump
Help topics can include graphics and text that link to other Help topics or to more information 
about the current topic.    These are called jumps.
Jumps are usually identified by a color and an underline (unless the jump is a graphic).    When 
you point to a jump, the pointer changes to a hand shape.
To choose a jump
Point to the text or graphic, and click with the mouse button.
Or press TAB to select the jump, and then press ENTER.
You can press SHIFT+TAB to move backward and select a jump.

If the jump you choose is linked to another topic, that topic appears in the Help window.    
Sometimes a jump is linked to information that appears in a pop-up window or a secondary 
window.

Note: When information is displayed in a pop-up window, the size of the pop-up window is 
proportional to the size of the main Help window.    If you want the pop-up window to be larger, 
you need to change the size of the main Help window.
To display all jumps in a topic

Press CTRL+TAB
To close a pop-up window

Click anywhere on the screen, or press any key.
To close a secondary window

Double-click the Control-menu box.
Or press ALT, SPACEBAR to open the Control menu, and then choose Close.

Related Topic
Moving Around in Help



Help Buttons
Help buttons are located along the top of the Help window and enable you to move around 
easily in Help.    If a feature is not available, its button name is dimmed.

 Button        Function
Contents Displays Help Contents for the application 

you are using
Search Lists all the words you can use to search for 

topics in Talking BookMakr Help.    By typing 
or selecting one of these words, you can 
search for and go to a specific Help Topic.

Back Displays the last topic you viewed.    You 
move back one topic at a time in the order 
you viewed the topics.

History Displays the last 40 topics you have viewed 
in the Windows session.    The most recent 
topic viewed is listed first.    To revisit a topic,
double-click it.

<< Displays the previous topic in a series of 
related topics, until you reach the first topic 
in the series.    The button is then dimmed.

>> Displays the next topic in a series of related 
topics, until you reach the last topic in the 
series.    The button is then dimmed.

To choose a Help button
Click the Help button you want.
Or type the letter that is underlined in the Help button.



Read Words
Play the Text Sound File while highlighting the text of each word as it is pronounced so learners 
can relate the appearance and the sound of the words.



Sound checkbox
The small check box in the upper right corner of the Question, choices and responses.    The 
check box in the picture is empty showing that it has no embedded sound file.    If a sound file 
has been attached, the check box will be marked with a check.



Question picture
The picture which may optionally accompany the multiple choice question.    The question may 
refer to the picture.



Question - Question Page
Also know as QPage.    Clicking this menu item switches to the Question Page domain.    In the 
QPage domain the author may test the question to determine that it is behaving as expected, 
and "tweek" the question so that it behaves as expected.



Objective
The objective of the LESN is the measureable outcome of the LESN.    A good objective 

might be, "Learn to read 80% of the words in the story."    A quiz can then say a word and have 
the student pick the written word from the list.    If the student gets four out of five correct, a 
score of 80% will be achieved and the objective of the LESN is accomplished.



Help Basics
Windows help provides a quick way to find information, such as how to perform a particular 
task.    Within a Help topic, there may be one or more jumps, which you can click (or select and 
press [Enter]) to display a new Help topic.
You can move, resize, maximize or minimize the Help window, just like any other window.
To return to Contents for "How to Use Help". choose the Contents button.



What Talking BookMakr Does
One of the main reasons that children and non-reading adults don't learn to read is that 

the reading material is not interresting to them.    With Talking BookMakr, users can quickly 
make Talking Books which capture familiar settings, persons, pets and things.    Talking Books 
can teach students to read about things that they already know and love.

With microphones for sound and graphics capture equipment such as scanners, video 
capture cards and frame capture plugs, Talking Books high-interest Talking Books can be made 
with pictures or videos of the home or school, family members, classmates, teachers.    Users fill
in the title and author information on the Title Page:

And the Reading Pages:



By clicking on the "Read Words" icon, , each of the words is highlighted and read out 
loud.    Pictures of familiar things make it easy to associate the picture of the person or thing with
the look of the word on the page and the sound of the word.    Selecting individual words by 
clicking on them pronounces the word aloud or gives a definition, or other information about the 
word.

Soon, most learners can read (and understand) the words themselves.



Font
The typeface of the text.    Fonts have different names, colors, styles and sizes:
Arial, black, normal, 12 point.
Arial, black, normal, 10 point.
Arial, black, bold, 14 point.
Arial, red, bold, 10 point.
Times New Roman, blue, italics, 10 point
Times New Roman, gray, underline, 12 point



Title (of a Talking Book)
The Title of a Talking Book is displayed on the title screen. The title should be descriptive.    It 
should provide a casual browser with an idea of what the Talking Book Lesn is about.



Previous
Returns to the previous domain.



Background
Related Topic:

How To Change The Background
Reading pages may have a plain, gradient or tiled wallpaper background.    The wallpaper tiles 
are composed of small pictures which are repeated next to one another in rows and then as 
many rows as are required to cover the page.

.
The gradient for Talking BookMakr up to version 1.1 is blue to black only



Viewing Help Contents
Help Contents lists available Help topics.    If you are viewing a Help topic and you want to return
to Help Contents, use the Contents Button.
To display Help Contents from within Help
Choose the Contents button in the Help button bar
Or type c.
Related Topics
Moving Around in Help
Getting Help from   Talking BookMakr  



Title Bar
The title bar shows the Titles of dialog boxes.    In the Synchro control, the title bar contains the 
current word or phrase which the sound is to read.



History Button
Displays a list of topics you have viewed. Use this button to revisit any of the last 40 Help topics 
you have viewed. The most recent topic appears first. The history button is in the Help button 
bar near the top of the Help window.



Returning to a Help Topic You Have Viewed
You can use the History button to see a list of the previous 40 Help topics you have 
viewed.    To return to a topic, choose it from this list.
To use the History button to return to a topic
1    In the Help button bar, choose the history button.
        Or type t.
2    Double-click the topic you want to return to (or select it and press ENTER).
        If necessary, use the scroll bar to see more topics.
        The History window stays open until you close it or quit Help.
To close the History window
      Double-click the System menu gadget.
        Or press ALT+F4



Insert LESN Diskette
3.    If the LESN is located on a removeable diskette, put a new formatted diskette into the drive 
you selected. (This message will be repeated for each diskette in the series.

Click on the Next arrow, , at the top of this window.



Title Page
Click on the items below for an explanation.    If the explanation is too long you will jump out of this screen.
To return to this screen, click on the Back button, , at the top of this window.



[F1] (Help)
Press the    function key at any time to get help on your current activity.    Just click on the item 
you want help on and press .
If you need additional assistance, click on the Contents button at the top of the Help screen.    To
look up specific topics or words click on Search at the top of the Help screen.    Double click on 
the System Menu Gadget in the upper left corner when you are through with Help.



Learning the Concepts of Talking BookMakr
Talking BookMakr Help is organized under four main headings: Concepts, Procedures, 
Reference, Help on Finding help.
To become familiar with Talking BookMakr concepts
1    From the Help Button Bar, select Contents.
2    Click on the underlined word Concepts.
3    Make a selection by clicking on an appropriate topic
4    Click on the << and >> buttons to browse through the Talking BookMakr Concepts 
sequence.
To get help on a specific concept
1    From the Help button bar, select Search
2    Type in the concept you wish to find help on.
3    Click on Goto for help on the concept.



Printing a Help Topic
You can print any Help topic. A topic prints on the default printer.    If you have installed more 
than one printer, you can make any of the default printer.    You can also change the options for 
the default printer.
To print the current Help topic
From the File menu (in Help), choose Print Topic.
To change printers and printer options
1    From the File menu in Help, choose Print Setup.
2    Select the printer you want to use.
3    To change the default printer options, choose the Setup button.    The options vary, 
depending on the printer you select.
4    Select the options you want.
5    Choose the OK button to close the printer's Setup dialog box.
6    Choose the OK button.

For help with the Setup dialog box, choose F1 while using the dialog box.
Note: You cannot print information that is in a pop-up window.



File-Print
In Lesn Domain, prints the entire Talking book on the user’s printer.    In Page Domain, prints the
current page.



File-Exit
Saves the current Lesn, if any, shuts down Talking BookMakr, and exits to MS-Windows.



 Next Button
Goes to the next page.    Asks for permission to create new page if next page does not exist.



Clipboard
A temporary storage area in memory used to transfer information.    You can cut or copy 
information onto the clipboard and then paste it into another document or application.



Topic
Information in the Help window.    A Help topic usually begins with a title and contains 
information about a particular task, command or dialog box.



Viewing Your Annotations
If you have added notes to a help topic, you can view them at any time.
To view an annotation
1    Click the paper-clip icon to the left of the topic title.
        Or press TAB to select the paper-clip icon, and then press ENTER.
2    When you finish viewing the annotation, choose the Cancel button.



Adding Text to a Help Topic
You can add your own comments and notes to a Help topic and view this information later.
To add text to the current Help topic
1.    From the Edit menu in Help, choose Annotate.
2.    In the Annotate dialog box, type the text you want to add.    If you make a mistake, press 
BACKSPACE to remove any unwanted characters, and continue typing.
Text wraps automatically, but you can end a line before it wraps by pressing ENTER.
3.    Choose the Save button.



Scrolling Through a Help Topic
If the content of a Help topic does not fit in the window, use the scroll bar.
To scroll through a Help topic
Click one of the scroll arrows to scroll one line at a time,m or drag the scroll box to scroll quickly 
through a topic.
Or use the arrow keys to scroll up or down.
To scroll up or down, one window at a time
Click above or below the scroll box in the scroll bar.
Or use the PAGE UP and PAGE DOWN keys.
Related Topic
Moving Around in Help



Searching for a Help Topic
You can find information quickly by using the Search button in the Help window.    The Search 
button opens the Search dialog box, where you select a word that you want to search for.    All 
Help Topics associated with that word are listed, and you can select one to view.    For example, 
to find out how to save a file, you could select "Save" from the list.    Topics that have the word 
"save" associated with them would then be listed in the Search dialog box.
To search for Help information
1 In the Help button bar, choose the Search button.

Or type s.
2. Select the word or phrase you want to search for.    When you start typing, the words that
most closely match the text you type are displayed.
3. Choose the Show Topics button.
4. Select the topic you want to view.    If necessary, use the scroll bar to see more topics.
5. Choose the Go To button.
Related Topic
Moving Around in Help



Shows a list of the files of the type listed below in the directory named (to the right).



Shows the name by which the file will called it is saved at this time.    Click on a name in the list 
box below to save the file by that name.    Type in a new name by which to save, if desired.



Highlight
To emphasize a word with color or a highlight box.    When being read, word backgrounds flash 
yellow.    A word selected by clicking is enclosed in a blue dash-lined rectangle.



Graphics Converter
Software which can change pictures from one format to another.    Since this version of Talking 
BookMakr uses "..bmp" graphics exclusively, it may be helpful to have a graphics converter.    
The Windows Paint program, in the "Accessories" group, can be used to load ".dib", ".pcx" and 
".bmp" files.    The file can then be converted to a bmp file by clickling on File | Save As , then 
clicking on the "Bmp" file type and saving the file.

Graphic Workshop, an excellent shareware program, can do graphics conversions and many 
other handy graphical manipulations.    Graphic Workshop is produced by:

Alchemy Mindworks Inc.
P.O. Box 500, Beeton
Ontario, Canada L0G 1A0

Telephone: 1 416-729-4969



Organization of Talking BookMakr Help
The documentation of Talking BookMakr is divided into five main groups.

Concepts 
These are the ideas related to what Talking BookMakr does.    They are background ideas 
needed or helpful in understanding specific reference or procedures.
Procedures
How to perform procedures such as making a lesson, selecting a template, and navigate 
through Talking BookMakr.
Reference
This includes a Glossary, functions of Talking BookMakr Windows, Icons and Menus and 
indexes of dialog boxes, tool bars and other MTS    components.
Help on Finding Help
This section explains how to use the Talking BookMakr Help system.
Tutorial
This section is included in the Getting Started manual which accompanies Talking BookMakr 
Pro.
Related Topics
Concepts
Procedures
Reference Section
Help on Finding Help



Help Menu Commands (in Help)
Use the scroll bar to see more commands.
How to use Help
Displays Contents for How To Use Help.    Choosing this command is the same as pressing F1 
while you are using Help.
Always on top
Causes all Help windows to appear on top of other windows.    After you choose this command, 
a shadow appears around the window borer to indicate that the Help windows are on top.



Indicator
A column of cells, which highlight the row of the current or active question object.    The indicator
in the picture is indicating "Choice C".



File Menu Commands
Use the scroll bar to see more commands.
Open
Opens a Help file.
Print Topic
Prints the topic that is in the Help window. You can print only entire topics.
Print Setup
Sets printer options before printing a topic. You can select a printer and set or change options 
for the printer.    The options available depend on the type of printer selected.
Exit
Quits Help and saves any annotations or bookmarks you created.



Picture Domain
In Picture domain the user may select or replace the picture on the page.    The QPicture 
domain is exactly like the Picture domain except the Picture domain controls the picture on a 
Reading Page and QPicture controls the picture on a question page.
Switch to Picture domain from a Reading page by clicking on . and , until the Domain window 
contains, "Picture".
Select a new picture by clicking on .    The Open File dialog will appear select the desired 
picture and click on [OK].    If the picture is larger than the display area, it will be proportionately 
scaled to fit.
View the picture (if not visible because a video has just been played) by clicking on view 
picture, .
Move to a new domain by clicking on it or pressing the    key or by clicking on . or .



Exporting a LESN Over the Internet
Related Topic: Importing a Lesn From the Internet

Exporting a LESN from your system copies the database files of the LESN and compresses the 
LESN database and media asset files to a single file in a target directory that you select on your 
hard drive or network.
This is the procedure to export a LESN to be transferred over the internet.
After examining each step of the process, click on the Next arrow, , at the top of this window.
From the File menu, click on "Export To Disk'

Click on the Next arrow, , at the top of this window.



Synchro Domain
A Reading page contains words, and a page sound file which says the words aloud.    In 
Synchro domain, the author indicates the end of each word segment so that Talking BookMakr 
can highlight each word as it is pronounced.    The Leader, and then each consecutive word in 
the text, will appear in the title bar of the Synchro Controller.    Work down the controller from top
to bottom,    "Approximate, tune in, fine tune".
Switch to Synchro domain on a Reading page by clicking on . or , until the Domain window 
contains, "Synchro".
Re-doing The Synchronization return to Synchro by selecting Synchro domain from the 
Domain Diagram or the Domain List Box.
Synchronize Word Highlighting to Word Pronunciation
Example: The leader (blank space before) "This is it."
1.    Click Longer on the top row of buttons, which is largest and adjusts the sound segment the 
most, to increase the length of, and play, the sound segment.
2.    Listen to sound segment
3.    If none of the word "This" is pronounced, repeat steps 1 and 2
4.    When the first part of "This" is at the end of the sound segment, click the "Shorter" button on
the next row down..
5.    When the sound segment is covering all of the dead space, but none of the word, click the 
"Freeze" button.
6.    The next word will appear.    If the word is completely pronounced, and none of the following 
word is pronounced, click the "Freeze" button.    Otherwise, click "Shorter" or "Longer" as 
needed and repeat steps 2 through 5.
7.    On the last word, shorten it to eliminate the trailing dead space (trailer) from being 
pronounced.      When the the last word is frozen, the domain will automatically change to Page 
domain.



Exit
Exit refers to exiting the current Lesn or exiting Talking BookMakr to MS-Windows.
1) Select File-Exit from the File Menu of the Main Menu.
Note: Start domain is the first domain, so by navigating backward, the user exits the Talking 
BookMakr software.    While in Start domain:
2) Click , , , [Previous Page], , 



Page Spinner (short)
The main control used to change the page.    Up arrow goes to higher-numbered pages, and 
Down arrow goes to lower-numbered pages.



Page Spinner
Click on parts of the picture to identify them.
The Page Spinner is the primary means of changing pages.    Click the Page Up and Page 
Down arrows to advance or return to the previous page.



Text-Save
Presents a file requester by which user names and saves a document.



Domains
Related Topics: Domain list box Domain window Changing Pages

Domain diagram Changing domains
Talking Bookmakr has 23 Domains, or topics, to fill in to make a Talking Book.    In each Domain,
the screen, will display only the items need to edit the object of the topic or to move to another 
topic domain.

For instance, in Words Domain, the object is the current word, so the menu items, 
screen controls and buttons which are used to modify the word are visible.    Controls, buttons 
and menu items which modify other objects (such as the picture) are not visible. Twenty-two 
Domains are normally accessable in Automatic Mode, by Continuing or clicking Previous.    

Users may go to these twenty-two activities plus the Lesn domain directly by clicking on them in 
the Domain List Box.
Click on Domains in the table above for descriptions.    There is also a new Objective Domain.



Font Size Window
The size of the font displayed in the Font Window is displayed in the Font Size Window 
immediately below and to the right of the Font Window.



Words-Edit 
Switches to Words domain, where user may click on a word to edit.



Title (Lesn)
In the entertainment and information industries individual books, CD's, or Lesns are called 
Titles.    In our context, if you have produced 3 Talking Books, you have produced 3 Titles.



Title Sound
The sound file which plays when the Title screen is played.



Talking Book Publisher



Freeze
Click here when the sound being read exactly pronounces the word or phrase in the Title Bar.    
Ideally, the sound should not clip off any of the word or start to say any of the next word, but 
sometimes this is impossible, because the sound of the words run together.    When the Freeze 
button is clicked, the word in the text controller will be "iced" in ice blue.



Viewing (text or media file)
Click on the following icons/menu item, to view the corresponding type of file.

View Picture
View Sound
View Video

Text|Open View Text File



Starting A New Lesn

To start a new Lesn click on File|New, the first selection in the File Menu.



Font Color
The Font Color icon is visible in domains that have a font: Lesn, Title, Author Name, Text, Word, 
Question and Choices.    Set the font color by clicking the Font Color icon,  , which will 
produce the color palette, .    Click on a color on the palette to change the color of the target 
object. 
The name of the font in the upper left part of the screen will also be displayed in the selected 
color.



DesignTime
The time when you are planning or constructing a Personal Reader Lesn.    Before the Lesn is 
played.



Select a Directory
2.    A dialog box will appear which will allow you to select the drive and directory to which the 
LESN will be exported.    Select the drive by picking a drive with enough free capacity to copy 
the whole LESN (usually your hard drive, but may be a network drive) from the Drive Selector 
dialog box.    Then click on the [OK] button.

Click on the Next arrow, , at the top of this window.



Current
The item that is active or selected at this time.      In Start Domain, there is no current Lesn, 
Page, Word, or Domain. With a Lesn started or loaded, the current Lesn is the Lesn that is 
loaded.    If there are no pages (other than the title page) the current page is zero (0).    If other 
pages are made, the current page is the one on the screen (the page number is in the upper left
corner of the screen).    In Word Domain, the current word is the one which is highlighted.



Font Style
The style (appearance) of the font.    The Font Style Selector displays the font styles: Bold, 
Italics and Underline.    If none are checked the style is "normal".    The Font Style icon is visible 
in domains that have a font: Lesn, Title, Author Name, Text, Word, Question and Choices.
Set the font style by clicking the Font Style icon,  , which will produce the Font Style Selector .    
Click the check boxes to change the font style of the target object.
 The name of the font in the Font Window will be displayed in the selected style.



Font Name

The Font Name icon is visible in domains that have a font: Lesn, Title, Author Name, Text, Word,
Question and Choices.    Set the font by clicking the font icon, , which will produce the Font List, 
pictured above.    Scroll through the list to change the font of the target object.
The name of the font in the upper left part of the screen will also be displayed in the selected 
font.



Import
Talking BookMakr LESNs can be transferred from one Talking BookMakr system to 

another.    A LESN which has been exported onto a distributable form, a "Lesn.zip" file or 
spanned to a set of diskettes, can be imported using the Talking BookMakr import function.
    LESNs can not be copied from one system to another with the Windows or DOS copy 
functions because LESNs contain a database entry which can not be copied in this way.

Unregistered trial versions of Talking BookMakr cannot import or export LESNs.



Page Down Button
Click to go on to the previous page.



Importing A LESN From the Internet
Related Topic: Sending an Exported a Lesn Over the Internet

After a Lesn has been sent to you, the process for importing it is exactly as it is for importing it 
from diskettes, a Zip-drive or any other medium.      You should receive a message as above, 
explaining who sent it and what the Lesn is about.

Note:    Be sure when you receive LESNs that you put them into different directories.    
Since all exported Lesn files have the same name, the old files can be overwritten.

When you import a Lesn which was received over the internet, you should list the source as the 
drive and directory where the LESN is located, rather than your floppy diskette drive.

Next Step:
Importing A Lesn



Types of Pages
There are three types of pages in Talking BookMakr:
Title Page - Introduces a Lesn.    Shows the name, author, objective and copyright of the the 
Lesn.
Reading Page - Shows a picture, and/or a video, and some text.    The words of the text can be 
read aloud, clicking on words pronounces, defines or provides additional information about them
Question Page - Reads a multiple-choice question and reacts appropriately based on the the 
user's answer.



Font Size
The point size of the font.    The Font Size Spinner displays available font sizes from 8 to 72 
points (a point is 1/72" tall).    The TrueType fonts (TT) that come with Windows 3.1 can be 
scaled from 4 to 127 points.    Select a size by clicking the up and down arrows of the Size 
Spinner.    The Font Icon is visible in domains that have a font: Lesn, Title, Author Name, Text, 
Word, Question and Choices.
Set the font size by clicking the Font Size Icon,  , which will produce the Font Spinner, .    
Spin the size with the spinner to change the font size of the target object. 
 The selected size displays in the Font Size Spinner and the Font Size area of the control panel 
(size is 1 in the picture).



Shorter
Decrease the sound segment to be played by the number of milliseconds in the increment 
display, and read the sound file segment.



Domain List Box (short)
List of all domains.    Click domain button to show domain list box, then click a domain to select 
it.



Domain Window
Displays the current domain.



Domain Button
Click to view the Domain List Box.



Video Domain
In Video domain the user may select or replace the video (.avi) on a Reading page.    The 
QVideo domain is exactly like the Video domain except the Video domain controls the video on 
a Reading Page and QVideo controls the video on a question page.
Switch to Video domain from a Reading page by clicking on . and , until the Domain window 
contains, "Video".
Select a new video by clicking on .    The Open File dialog will appear.    Select the desired 
video and click on [OK].    If the video is larger than the display area, only a portion of the video 
can be viewed through the window.
View the video by clicking on View Video, .    If "manual" play is set, you may control the action 
of the video with the Video Controller buttons.    The video will not be Over until it has reached 
the last frame in the video file so if it is stopped in manual control mode, Lesn flow will not 
progress untill the last frame has been played.
Set Auto/Manual play by clicking    (Manual) and    (Automatic).    This controls whether the 
video plays straight through, automatically, or whether the Video Controller is visible for user 
control of the video.
Move to a new domain by clicking on it or pressing the    key or by clicking on . or .



How To Read Icons
Related Topics

Index of Icons
Icon Bar
Icon Scroll Arrows
Talking Bookmakr containts 24 icons.    Understanding the paterns behind them makes it 

easier to understand and remember them.

Selecting and viewing media
Talking BookMakr uses 3 media: pictures, sounds and video.      Icons with a picture, , 

refer the the picture on the current reading page while icons containing a camcorder, , pertain to
video.    Speaker icons, , relate to sound of the current object, Title, Text, or and individual word.  
The "S"    in the lower right corner means, "Select file with the File Open Dialog", while "V"    
means, "View the indicated picture, video or sound".

Navigation
The    and    icons mean Continue and Previous, respectively to move forward or 

backward to the next or previous step in making a Personal Reader.    The Exit Sign, , means 
exit from the current context, Lesn or the Talking BookMakr software.

General
Icons with the "A" typeface, , refer to the Font, while    means to print the current context; 

either the current page or the whole Lesn.      means "Create New" context, Lesn or Page.

Text and Words
The process of entering the new Text, , may be followed by dividing the Text into 

separate Words .    Word generation and editing may be followed by Word Re-alignment,    and 
following synchronization, to commanding the system to Read the words, .

Toggle Icons
There are two icons which toggle in the same space so that if one is visible the other can

not be.    The first toggle is    and , meaning, "start recording sound", and, "stop recording" 
respectively.    The second toggle pair is    and    with the Manual Video Controller Dimmed or 
Active.    The icons mean User-Controlled, and Automatic Video Play, respectively.



Registration Number of Software (embedded)



Run (of CD’s)
A single lot of identical CD's manufactured at the same session.



Enumerator
The letter preceding the choice in a multiple choice question (A, B, C or D).



Question (stimulus)
The stimulus of a multiple choice question is called the question.    Following the question are 
the possible choices to correctly answer the question.



Words-Read 
Reads (highlights the word and plays part of a sound file which pronounces the word) the words
on the page if:    1) There are words, 2) there is a text sound file, 3) the words and sound file 
have been synchronized with the Synchro Control.



Words-Synchro 
Synchronizes the entire text sound file.    Removes any previous synchronization.



Edit Menu



File Menu
Click on Menu items on this File Menu picture for explanations of their functions.
The File menu in Talking BookMakr deals with the basic unit, the LESN.    The type of Lesns 
made by Talking BookMakr are called Personal Readers.



Insert a Diskette
3.    A dialog box will direct you to place a diskette into the drive.    Insert a formatted diskette 
containing no files into the drive you specified.    If the remaining size of the compressed LESN 
file exceeds the capacity of the diskette, you will be prompted to put in a second (third, fourth, 
etc.) diskette until the LESN file is completely copied.    Label the disks with the LESN name and
disk number.

Click on the Next arrow, , at the top of this window.



Export Complete
Related Topic:

Importing a LESN
Exporting a LESN Over the Internet

4.    If the export is successful, the LESN you exported will be ready to import into any other 
other Talking BookMakr system.    A dialog box will appear notifying you that the LESN was 
successfully exported.

This is the last frame of "How to export a LESN".



Bookmark Menu Commands
Use the scroll bar to see more commands.
Define
Places a bookmark in the current topic or removes a bookmark from any topic.    The name you 
specify for the topic appears on the Bookmark menu.
List of Bookmark Names
Appears after you have defined a bookmark. From this list, you can choose the bookmark for 
the topic you want to display in the Help window.
More
Appears when you have defined more than nine bookmarks.    Displays the complete list of 
bookmark names you have defined.



CD (Compact Disk)
A high-capacity optical storage disk.



Student Feedback Making a Response

Notice in the pictures that the current bank of colored indicators on the right are outlined 
in red, showing both the current response (A, B, C or D) and the current selection (1st or 2nd).    
The corresponding Selection Control is also highlighted in red.

In the next frames we will show only .    The other responses work in the same way.
For clarity, we will show only the 1st Selection and the selected response:    the second 

selection and the other responses work in the same way.

Click on the Next arrow, , at the top of this window.



Student Feedback Making Remediation

The remediation component of the student feedback is an attempt to teach, re-teach or 
show the correct choice to the user.    Remediation teaches with reading pages.    The author 
can select any reading page in the LESN.    At runtime, if remediation is indicated, the indicated 
reading page will play and then return to the question, where the question may be repeated or 
the student can move on.

To Give No Remediation
1. Click on the response text box you wish to edit.
2. Click on “None” in the Remediate group box of the appropriate Selection Control.

To Play a Reading Page
1. Click on the response text box you wish to edit.
2. Click on “Play pg __” in the Remediate group box of the appropriate Selection Control.

At run time the remediation here will go back to the reading page, then return to this 
Question page and go through the “Next Action” which can repeat the question, jump to any 
page (based on the students demonstrated skill deficit), or go to the next page.

To Show the Correct Choice
1. Click on the response text box you wish to edit.
2. Click on “Show corct” to show the correct choice.    (Make sure that at least one of the 

choices is correct, that is, has a value of 100%).

At run time, the “Show Correct Choice” remediation will highlight the first correct choice 
and say, “This is the correct choice”.

Click on the Next arrow, , at the top of this window.



Domain Diagram
Always on Top when visible.    Displays the current domain in red (e.g. Picture in the picture 
above).    Can give a hint of what the domain does, or can move to a new domain.

To see a hint of what the domain does
From Talking BookMakr, hold the cursor over the domain name in the diagram.

To switch to a domain:
1.    Click on Activate radio button.
2.    Click on the domain name in the diagram.

To close the Domain Dialog box:
1.    Click the Ok button or
2.    Double-click the System Icon in the upper left corner.



Printing



File-Play
Turns the current Talking Book to the title page and sequentially presents each page, playing all 
media on the page, and reading all text.    File-Play stops when the last page has been played.



File-Delete
Delete the current Talking Book.    The user will be warned that the Talking Book is about to be 
deleted from the system, so that the delete command may be canceled.



System Menu
Clicking on the system gadget brings down the system menu.    The system gadget is on all dialog

boxes.



Synchronization (text and sound)
Each page of Talking Book may contain words madef from text typed in by the author.    There 
may also be a sound file reading this text.    Synchronization of text and sound means 
coordination of word highlighting so that each word is highlighted while it is being spoken by the 
sound file.



Sound File
A file which is loaded by, or recorded and saved with Talking BookMakr.



Database
A program which saves and recalls information.    The Talking Book information is stored in a 
Paradox database.



Lesn Version
When Lesns are made, they are branded with a version number.    Those Lesns then require a 
playback module (included in Talking BookMakr) compatible with their version number.    The 
current version number is 1.2 .



Words Editor
The Words Editor is the white edit box with a black outline box containing all of the words.    The 
words are made up from the text entered into the blue text editor.



How to Use Shortcut Keys
Related Topic
        Shortcut Key Sequences
You can use the keyboard for most Talking BookMakr functions instead of the mouse.

For instance, in the menu bar above, you can click with the pointer on the word File to activate 
the File menu.    It will pull down a group of menu items.    To perform the same function with the 
keyboard, notice that the word File has an underlined character, "F".    This means that you can 
select this item from the keyboard by pressing the      (Alternate key), then the "F" key.    Most 
Talking BookMakr functions can be performed in this way, using either hot keys or the mouse 
pointer.



Student Feedback Design Interface

Design time is when the author of a lesn is designing and assembling the LESN.    The 
run time is when the learner is playing the LESN which was created by the author.    

Click on the yellow labels above for explanations of the different parts of the Question 
Page at Design time.

Click on the Next arrow, , at the top of this window.



Student Feedback Overview

After examining each step of the process, click on the Next arrow, , at the top of this 
window.

In the response Domain, LESN authors can easily set up sophisticated feedback to user 
selections.    Feedback closes the learning loop and helps students learn.    A summary of the 
feedback process looks like this:

1. Talking Bookmakr asks a Question (presents a stimulus).    The question consists of text 
and may have an attached sound file which reads the text of the question.    A picture, to 
which the question may allude, may also be included.

2. Talking Bookmakr presents two to four choices, at least one of which is correct.    Correct
means that selection of the choice earns 100% of the value of the choice.    More than 
one choice may be correct, but at least one selection must be correct.    Incorrect choices
may be valued between 1% and 99%.

3. The student selects one of the choices by clicking on it.
4. Talking Bookmakr may then provide feedback to the user.    There may be three 

components to this feedback:    Response, Remediation and Next Action.
5. One of the "Next Actions" is to repeat the question.    The question may be presented 

either one or two times, but no more.

To select the response you wish to edit.
1. Get into response domain by clicking the continue arrow.
2. Click on the response text box beneath the words "Custom Response" for the response 
you wish to edit.
The selection indicator on the left side of the choices will highlight in the row you clicked.

Once you have selected a response item, you may type the text of the response into the 
box.    Then use the sound buttons to record or load a sound file to be played while the text of 
the response is displayed.



Click below for explanations of the components of student feedback, responding to the student, 
providing help, and then taking another action:
Response 
Remediation 
Next Action

Click on the Next arrow, , at the top of this window.



Remediation
The possible second phase of feedback to a user selection is an attempt to teach or reteach, 
called remediation.    
Current types of remediation are:
1. NO remediation.
2. Visually and orally show the correct choice.
3. Display a reading page of relavent material, automatically display its picture, read its text
and run its video, then return to the question.



Response
The first of three parts of the student feedback to questions, response may be of several types:
1. An acknowledgement that the user made a selection, such as "Thank you", or "Selection
Received".
2. A hint such as, "Remember to multiply, not to add".
3. Show the correct answer, or
4. There can be no response.
Talking Bookmakr has default text and sound files for both which indicate correct and incorrrect 
answers or LESN authors may make custom responses to any or all possible responses.



Talking BookMakr User Manual
The Talking BookMakr user manual is online.    It is composed of this Windows Help system and 
an indexed animated tutorial to be released later.



Catalog of Products 
Related Topic:

Edutronics LLC Website
Talking Bookmakr for Windows 95, Book Publisher, Snappy Video Capture, Talking Books for 
Windows 95, Modems, Book Publisher Kit for Windows 95, Camcorders, CD Production, One-
off Talking Books on CDs, Run (a), Video Capture Card, Lesn Launcher, Spell-Right Speller, 
BookMakr Guide enhanced Windows Help / Tutorial System, BookMakr Pro, Runtime License, 
Telephone support, Printed Manual, Printed Manual & System Disks, Graphics Converters



Media
The sound, video and picture files you use to make up your Talking Books.



How To Create a Question Page
1.    With a LESN loaded (by Opening a LESN or by starting a new LESN), click on the      
button.
2. The New Page dialog( above) will appear.    Click on the "Question" radio button.
3. Click on the Yes button.



Decrease Increment
Decreases the size of the increment.    If the size of the increment is decreased from 100 to 20.   
Then each time the Longer or Shorter buttons are clicked, the sound file segment will be 
lengthened or shortened by 20 milliseconds instead of 100 milliseconds.    Decreasing the size 
of the increment can help you to fine-tune the length of the sound segment when you get it in 
the neighborhood of the right length.



Complete Export to Directory
4.    If the export is successful, the LESN you exported will be compressed into two files on a 
directory on your computer.    The names of the two files are always, "LESN.LSN" and "DISKID". 
The "lesn.lsn" file contains the lesn itself and the "diskid" file is used to authenticate the lesn 
when it is spanned over multiple diskettes.. The LESN file, "LESN.LSN", may be sent over the 
Internet to enable the receiving party to import the Lesn into the his or her Edutronics software, 
such as Talking BookMakr.

Note also that since all Lesns export to the same file names, "lesn.lsn", and "diskid", 
that each LESN for upload or download must be placed in its own directory so that it 
does not overwrite an existing LESN of the same name in the same directory.
 
A dialog box will appear notifying the user that the LESN was successfully exported.    Write 
down the path and file name of the files, such as "c:\temp\lesn.lsn" and "c:\temp\diskid.

Click on the Next arrow, , at the top of this window.



Attach LESN File(s) to the E-mail

E. Type in the name of the LESN file, "Lesn.lsn", to attach or select it with a file 
browser as above by clicking [Attached File].

F1. Attach the "LESN.LSN" file to the E-mail.    OR
F2. Get both file names into the attachment list, then click on [OK].

Click on the Next arrow, , at the top of this window.



Set Up an E-Mail
5.    There are several ways to send a file over the internet including, FTP (File Transfer 
Protocol" and HTTP.    If you know how to transfer files this way, go ahead.    The method that is 
best known to most users is to simply attach the "Lesn.lsn" export file to an e-mail (electronic 
mail) message.    The pictures show the Netscape E-Mail system; yours may be slightly different.

A. Start up your e-mail program and select "Send a message", however that is done
with the e-mail software that you use.

B. Enter the address to which you will send it.
C. Write a message to explain what the LESN attachment is and who you are.    (If 

you are donating a Lesn to the Edutronics LESN Consortium for public use, please affirm that 
you own or have legally licensed all media in the Lesn (if, in fact, that is the case), and that you 
wish to release the lesn to the public domain, with your name and the date.)

D. Click on [Attachment] (or a comparable method of attaching a file to an e-mail on 
your software).

Click on the Next arrow, , at the top of this window.



Send the E-mail
Related Topic: Importing Lesns Over the Internet

Exporting A Lesn

G. Check for errors and then send the e-mail.    Leave the computer on until the e-
mail transmission is complete.    With a Lesn of several megabytes, the e-mail transmission will 
take some time.    With the Netscape E-mail pictured above, the e-mail is not done until the red 
"stop light" goes out.    Be sure that the transmission is complete before you shut down your 
computer.    An incomplete file transfer results in no importable LESN.

The receiveing party should now be able to import the Lesn file directly into their Edutronics 
software with the File|Import function..

This is the last frame of "How to Export a Lesn Over the Internet".



How to Make a Question
Talking BookMakr can now ask multiple-choice questions and respond to student answers.    
The question stimulates the student to make a choice, and may be called the stimulus. To make 
a stimulus, or question:

1. Create a Question page.
2. Select a picture,    if desired    OR

Click the RIGHT mouse button to continue to the next domain.
3. Select a video, , if you wish    OR

Click the RIGHT mouse button to continue.
4. Click the Question Window until the cursor appears,    then type in the text of the 
question.    The text may scroll up while you are typing, making the some of the text disappear.
5. Record    or select    a sound file to accompany the question.    The sound file will usually 
read the text of the question    OR

Press the    key on the keyboard to advance.



How To Set Parameters for All Choices
All choices and their enumerators have the same font attributes of type face, color, size and 
style.

Setting the Number of Choices
1. In a Question page, enter Choices domain by clicking the Next and Previous buttons 
until the Domain window displays "Choices".
2. Use the Choices Spinner, pictured above, to set the number of choices to the questioin. 
The range is from two to four.

Setting the Font Attributes of the Choices



How to Create a Choice
Talking BookMakr questions can have two to four possible choices.    Correct choices 

have a value of 100.    One or more choices may be correct, that is, they may have a value of 
100, but at least one choice must have a value of 100 or the student can never obtain a 
"correct" selection.

 To make a choice:

1. Select the choice by clicking on it.
2. Type in the text of the choice.    The text may scroll up while you are typing, making the 
some of the text disappear.
3. Record    or select    a sound file to accompany the choice.    The sound file will usually 
read the text of the choice    OR

Press the    key on the keyboard to advance to the next choice.    OR
If you want to change the value, click on the Value Window for the choice then use the 

spinner (up and down arrows beside the value) THEN press the    key on the keyboard to 
advance to the next choice



Correct
Each choice to a multiple choice question has a value between zero and one hundred.    A 
correct choice has a value of 100.    More than one choice may be correct, but at least one 
choice must be correct.    Incorrect choices may have a partial credit value between 1 and 99 or 
they may have a no credit value of zero.



Importing a LESN
Related Topic:

Exporting a LESN
Importing a LESN From Over The Internet
This is the procedure to import a LESN which has been exported from Talking BookMakr

to a CD, directory or spanned over a set of diskettes.
After examining each step of the process, click on the Next arrow, , at the top of this 

window.
1.    From the File menu, click on "Import From Disk'

Click on the Next arrow, , at the top of this window.



End Window
Shows the end location of the current word (in the Synchro Title Bar), in the page sound file.    
The number of milliseconds into the sound file at which the current word ends.    This number is 
changed by clicking the arrows on the left.



Start Window
Shows the starting location of the current word (in the Synchro Title Bar).    This is always zero 
for the leader (the blank space before the first word).    The number is the number of 
milliseconds into the sound file at which the last word ended and the current word begins.    This 
number cannot be changed on the current word, it was set on the previous word.



Page 0
The Title Page of the Lesn.



Page
A screen of the Talking Book.    The Title page is said to be page 0, and each reading page (or 
question page) is numbered, starting at page 1.



Ordering Other Products
Edutronics can provide one-off CD's of your LESN's, licensed versions of Talking BookMakr and
the ability to publish your LESNs into Paper Books which you can print out on your own printer.   
Please consult our Website at WWW//Edutronics.com or click the About Box (under the Help 
menu) on the Talking BookMakr for our address.



One-off (CD)
Producing a single CD or a series of CD's, one at a time rather than by mass production.    
Edutronics LLC can produce stand-alone CD's of your LESN's.    Contact us on our Website 
(Edutronics.com) for further details.



Page Number



Media Files
Sound (---.WAV), graphic (---.BMP) and video (---.AVI) files.    A copy of the files selected or 
recorded are put into the Lesn’s    directory as they are selected or recorded.



Navigation (short)
Navigation is using the mouse buttons and/or the keyboard to select buttons, dialog boxes, edit 
windows, etc. to move from 1) one activity to another, like recording sound, editing the color of a
word or playing the Lesn, 2) one page to another, such as Page 1, the first Reading Page, or 
The Title Page, the first page in any Personal Reader 



File-Printer Setup
Link to the Windows Printer Setup utility to select or configure your printer.



Playing the Lesn
To play the current page of the Lesn, from the Page domain, click on Page|Play from the Page 
menu.
To play all of the pages in the Lesn, click on Lesn|Play.



Software License



Question Number Window 
The window to the left of the Repeat button, which shows the number of 

questions which have been answered.    Answering the same question twice counts as 
two answers.



Software Version



Edit-Delete
Deletes user-selected text from the document.



Edit-Select All
Selects all text in the document.



Reading Page
We will now make a Reading Page like the one below.    It has Text on the left and a picture on the

right.    The Read Text icon, , reads the text aloud and highllights each word as it is read. Readers can 
click on each word to pronounce it, spell it, or provide additional information about the word.    We will first 
enter the text then break it into words.    We will then attach a sound file and special font settings to some 
of the words.

Click on the items below for an explanation.    If the explanation is too long you will jump out of 
this screen.    To return to this screen in the tutorial, click on the Back button, , at the top of this 
window.



Exit Lesn
Exit refers to exiting the current Lesn to Start domain or exiting Talking BookMakr to MS-
Windows.
Note: Title domain is the first domain in the Lesn, so by navigating backward, the user exits the 
Lesn to Start domain.    While in Title domain:
Click , , , OR [Previous Page], exit the Lesn.



Text Domain
Enter Text by typing it into the text box.
Change font characteristics of all text for page by clicking the font attribute buttons, , . ,    .
Record the page sound file by clicking on .
End text entry by clicking on 



Page Domain
Is used to test a reading page.

Select a Word    by clicking on it.
Edit a Selected Word by typing in the word box.
Adjust the size of all word boxes by clicking .
Change font characteristics of a selected word by clicking the font attribute buttons, , . ,    .
Record the page sound file word by clicking on .
Read the text by clicking on .



Copyright Holder Domain
Type in the name of the person or company who owns the common law copyright of the Talking 
Book, then Continue (can also press    or    to continue).
Options: Exit:, Return to Previous, Change Page, Change Domain.



Author Last Domain
Type in your last (family) name.    If desired, edit the font with the Font Icons, then Continue    
(can also press    or    to continue).
Options: Exit:, Return to Previous, Change Page, Change Domain.



Author First Domain
Type in your first name.    If desired, edit the font with the Font Icons, then Continue    (can also 
press    or    to continue).
Options: Exit:, Return to Previous, Change Page, Change Domain.



Title Domain
Type in the Title of the Lesn.    The title is limited to 2 lines.    Select or record sound by clicking 
on , or , respectively.    If desired, view the Title sound, , edit the font with the Font Icons, then 
Continue    (can also press    or    to continue).
Options: Exit:, Return to Previous, Change Page, Change Domain.



Changing Pages
There are several ways to move to a new page.
Page Spinner
Back and Next Buttons
Changing Domains will change pages if the user selects a domain which is not on the current 
page.    If the user is in Text domain on Reading Page 3 and selects the Title domain, the page 
will change to page 0



Domain List Box (detailed)
Click on items in the picture to identify them.
Show the domain List Box by clicking the domain button next to the domain window.    The 
current domain will be highlighted in the list box when it appears, and the selected domain will 
be visible at all times in the domain window.

The user may change domains by clicking on the desired domain in the Domain List 
Box.    



Word Window
After the text is divided into words, each word is encased in an individual word window,    if the 
size of the font is changed, the word may be too large or small to be viewed through the word 
window.    The size of all word windows can be adjusted by clicking the Word Alignment Button.



Words
Individual objects made from the text.    Each word has it’s own font, color, size, location, 
sequence, sound file, hint and window.



Word limit (per page)
The maximum number of words per page is 150.    Since there is a limit to the number of words 
per page but there is no limit to the number of pages, just break up ideas onto more than one 
page.



Video For Windows
A video storage and reproduction standard from Microsoft Corporation.    Video for Windows files
have the extension, ".avi".



Copyright Location Domain
Type in the City, State/Province, Country of the person or company who owns the common law 
copyright of the Talking Book, then Continue    (can also press    or    to continue).
Options: Exit:, Return to Previous, Change Page, Change Domain.



Copyright Date
Set automatically.    The year (according to the system clock) is placed into this domain when the
Lesn is created.    The copyright date cannot be accessed by the author.



Author Middle Domain
Type in your middle name or initial.        If desired, edit the font with the Font Icons, then 
Continue (can also press    or    to continue).
Options: Exit:, , return to Previous, Change Page, Change Domain.



Lesn Domain
Is used to set font values for all new pages and backgrounds for all Reading and Question 
Pages.
Enter Lesn Domain
1. Click the Domain button.
2. Select "Lesn" domain.
Change the background
1. Click on 
2. Select the type of background you desire.
3. If you select, "Wallpaper" the open File dialog will appear: select a picture and click [OK].



Word Sound File
A separate sound file, ennunciating, defining, spelling or supplying other information about the 
word.    The Learner plays the sound file by clicking on it.



Edutronics L.L.C. Web Site
The Edutronics Website is located on the internet at

 www//edutronics.com.
At the Edutronics Website you can download new software for free home evaluation, learn the 
latest news about Analytical Education, (teaching learners according to their preferred learning 
styles) and learn about the latest products and upgrades.
You may also order hardware which you may need to make LESNs including, complete LESN 
Workstations, microphones, speakers, graphics capture cards, video capture cards, etc.



Text Sound Domain
The domain in which the text sound file is recorded (or loaded) and may be played, or re-
recored until it is satisfactory.



Words Domain
Select a Word    by clicking on it.
Select the next or previous word by holding down the    key then pressing the left or right 
arrow keys.
Edit a Selected Word by typing in the word box.
Adjust the size of the word box by clicking .
Move a Selected Word by holding down the    key then pressing the arrow keys.
Change font characteristics of a selected word by clicking the font attribute buttons, , . ,    .
Record a sound file for the word by clicking on .



Version
As Talking BookMakr software evolves the different releases will have progressive version 
numbers.    The Lesns these software versions make are branded with this same number. Lesns
need runtime software which has a compatible version number.



Video Controller

The Video Controller has buttons like a tape player or VCR:
Play, Stop, Pause, Last Frame, First Frame, Move Forward, Move Backward.
The Video Controller may be visible, allowing the user to control the video, or the video may 
play automatically, without user input.



Video File
A Video For Windows movie. (---.avi)



Text-Save As
Used to save a text file with a new name or to a new location (or both).



Page-Next
Turns to the next page of the Talking Book.    Requests permission to create the page if it does 
not exist.



Page-Insert
Inserts a new page into the current lesson and re-numbers the pages following the insertion.    
Page-Insert is available only on Talking BookMakr Pro.



Page-Delete
Deletes the current page from the current lesson and re-numbers the pages following the 
deletion.    Page-Delete is available only on Talking BookMakr Pro.



Page-Play
Plays all media on the page, and reads all text. 



QVideo Domain
In QVideo domain the user may select or replace the video (.avi) on a Question page.    The 
QVideo domain is exactly like the Video domain except the Video domain controls the video on 
a Reading Page and QVideo controls the video on a question page.
Switch to QVideo domain from a Question page by clicking on . and , until the Domain window
contains, "QVideo".
Select a new video by clicking on .    The Open File dialog will appear.    Select the desired 
video and click on [OK].    If the video is larger than the display area, only a portion of the video 
can be viewed through the window.
View the video by clicking on View Video, .    If "manual" play is set, you may control the action 
of the video with the Video Controller buttons.    The video will not be "Done" until it has reached 
the last frame in the video file so if it is stopped in manual control mode, Lesn flow will not 
progress untill the last frame has been played.
Set Auto/Manual play by clicking    (Manual) and    (Automatic).    This controls whether the 
video plays straight through, automatically, or whether the Video Controller is visible for user 
control of the video.
Move to a new domain by clicking on it or pressing the    key or by clicking on . or .



QPicture Domain
In QPicture domain the user may select or replace the picture on a Question page.    The 
QPicture domain is exactly like the Picture domain except the Picture domain controls the 
picture on a Reading Page and QPicture controls the picture on a question page.
Switch to QPicture domain from a Question page by clicking on . and , until the Domain 
window contains, "Picture".
Select a new picture by clicking on .    The Open File dialog will appear.    Select the desired 
picture and click on [OK].    If the picture is larger than the display area, it will be scaled 
proportionately to fit.
View the picture (if not visible because a video has just been played) by clicking on View 
Picture, .
Move to a new domain by clicking on it or pressing the    key or by clicking on . or .
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View Video
View (play) the selected Video for the current page.    The video is presented in a frame either 
automatically or with a video controller which the user can adust manually.
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Icon Scroll Arrows
If the Icon Bar contains more icons than can be displayed at once, the Icon Scroll Arrows will 
become active.    Click on the Right or Left Icon Scroll Arrows to scroll the icons in the 
direction of the clicked arrow.



Editing Words
Select a Word
The word is selected, or current, when it is enclosed in a dotted-line box.
1.    Enter the Words domain
2.    Click on the word OR
3.    Hold down the    key while pressing the (right arrow key) to move the selection to the next 
word OR
4.    Hold down the    key while pressing the (left arrow key) to move the selection to the previous
word 
Edit the Text of a Word
1.    Select the word
2.    Click the right and left arrow keys to move the cursor between the letters of the word
3.    Type in other text, delete or replace letters
4.    Resize the word windows of edited words and re-align the text by clicking the Re-align 
Words Icon, 
Move Word
Words can be moved to the exact pixel-level location desired.
1.    Select the word
2.    Hold down the    key while pressing the (right arrow key) to move the word one pixel to the 
right OR
4.    Hold down the    key while pressing the (left arrow key) to move the word one pixel to the left
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How To Synchronize Text and Sound
Related Topic:
             Synchro Sound Synchronization Tool  

After typing in text, converting text to separate words, and recording a sound file which reads 
the words, use the sychro controller (above).    To identify the end of each word in the sound file. 
Clicking the "Shorter" and "Longer" buttons will increase or decrease the size of the sound 
excerpt by an incremental number of milliseconds.    The amount of the increment is in the 
Increment Window on the left of the controller.    You may increase or decrease the size of the 
increment by clicking the small up and down arrows next to the Increment Window.    Smaller 
increments will require more clicks to find the exact dead space between words but the author 
will have better resolution and more accuracy.    100 milliseconds (100/1000 sec. or 1/10th sec.) 
is the default.    Adjust the increment to suit.    When the sound excerpt pronounces the word 
correctly, click the "Freeze" button to freeze the end point of the sound file excerpt.

The sound file in the example reads "This is a dog."    The author indicates the end of the
leader, (before the first word) and the end of each word so that the word can be highlighted as 
the part of the sound file reading the word is played.    The Leader, and then each consecutive 
word in the text, will appear in the title Bar of the Synchro Controller.
Work down the controller from top to bottom,    "Approximate, hone in, fine tune".
To Synchronize Word Highlighting to Word Pronunciation
1.    Enter Synchro domain.
2.    Start on the top row of buttons.    The top row is largest and moves the end of the sound 
segment the most.    Click Longer button (this will increase the length of the sound segment and 
play the sound segment) 
3.    Listen to sound segment
4.    If none of the word "This" is pronounced, repeat steps 2 and 3
5.    When the first part of "This" is at the end of the sound segment, go down to the next row of 
buttons and click the "Shorter" button.
6.    When the sound file is covering all of the dead space but none of the word, click the 
"Freeze" button.
7.    The next word will appear.    If the word is completely pronounced, and none of the following 
word is pronounced, click the "Freeze" button.    Otherwise, click "Shorter" or "Longer" as 
needed and repeat steps 3 through 6.
8.    On the last word, shorten it to eliminate the trailing dead space (trailer) from being 
pronounced.
9.    When the author freezes the last word, the domain will automatically change to Page 
domain where the author may click      to hear the words played.

Re-doing The Synchronization
When the words have been synchronized, the Continue/Previous buttons will skip Synchro 
domain because returning to Synchro will reinitialize (destroy) any existing synchronization.    
Users wishing to re-synchronize the words may return to Synchro by selecting Synchro Domain 
from the Domain Diagram or the Domain List Box.



Index of Browse Sequences
    Browsing Through Help Sequences

If the browse buttons (<< and >>) appear in the Help window, it means certain Help 
topics have been grouped together in a sequence.
    To view the next topic in the browse sequence

Choose the >> button on the Help button bar.
Or press the period (.) key.
When you reach the last topic in the sequence, or if there is no browse sequence, the >>

button is dimmed.
    To view the previous topic in the browse sequence

Choose the << button on the Help button bar.
Or press the comma (,) key.
When you reach the first topic in the sequence, or if there is no browse sequence, the <<

button is dimmed.

Help Browse Sequences
    Click on the name of the browse sequence below to jump to the first topic in the sequence.

Background
Overview of Talking BookMakr
Windows Terminology

Using Talking BookMakr
Making a Personal Reader Lesn
Ancillary Activities
Making Responses To Student Choices

Components of Talking BookMakr
Talking BookMakr Screens
Dialog Boxes
Menus
Icon Bar
Individual Controls

Help
Using Help
Sections of Help
Advanced Help



Question Icons
Related Topic:

Icon Index
Icon Bar

The icons relating to producing a multiple choice question are pictured above.    They will appear
in the top-screen button bar at appropriate times as the Question is being put together.

A Hint Box will pop up if the mouse is placed on the icon for a second.

The author must create a question page for the question icons to appear.

Click on the icons above to learn what they do.



Page-Back
Returns to the previous page.



Custom Response
LESN authors may override Talking BookMakr's "Default Responses", and make their own 
custom responses.    There can be a custom response for each choice in the question.    Each 
response may be in text, (which will appear in the Custom Response box if the choice is 
selected) and sound (which can read the text or provide other comment, encouragement or 
information).    The Custom Response box appears, the sound file is played and then the text 
box disappears.



Longer
Increase the sound segment to be played by one quarter of the number of milliseconds in the 
increment display, and read the sound file segment.    Increases by a medium amount.



Increment Display
Shows the number of milliseconds ( 1/1000th second) which will be added (by Increase 
Increment), or subtracted (by Decrease Increment) from the segment of the sound file which is 
played by the Synchro control.



Saving a text file

How to Save a Text File
Click Text|Save.

How to Save a Text File to a New Path
1.    Click on Text|Save As from the Main Menu.        The Save File Dialog Box appears,
2.    To Change Drives: Click on the down arrow to pull down the list of Drives in the Drives 
Combo Box, and double click the desired drive    OR
3.    When the desired Drive is selected, to change directories: Click on the down arrow to pull 
down the list of Directories in the Directories Combo Box, and double click the desired directory  
OR
4.    When the desired Directory is selected, To select the name of the file to be saved, type a file
name into the file edit box and press [Enter]    OR
5.    Clilck the [Cancel] button to Cancel without saving a text file.



Select
To click on an object used to input data into a domain, making the object the current object. 
Examples: A word object, title object, question object, choice object, response object.



Export
Talking BookMakr LESNs can be transferred from one Talking BookMakr system to 

another.    To put the LESN in a distributable form, the LESN must be exported using the Talking 
BookMakr Export function.
    LESNs can not be copied from one system to another with the Windows or DOS copy 
functions because LESNs contain a database entry which can not be copied in this way.

Unregistered trial versions of Talking BookMakr cannot import or export LESNs.



Create A Lesn
Create a new Lesn by:
1.    Clicking New Lesn, , from the Icon Bar in Start domain.
2.    Clicking the Next Page button, , in the lower right corner of the screen from Start domain.
3.    Clicking File-New from the File Menu.



Text-Open
Presents a file requester from which the user may open an ASCII text document. (The extension
of the file will probably be *.TXT)



Text-New
Deletes all text in the Text Control.    Used to start the text all over.



How To Navigate Through Talking BookMakr
Related Topic
      Exiting Talking BookMakr
Talking BookMakr has 22 domains or areas of activity.

Entering or Exiting a Lesn
The largest groupings within Talking BookMakr are: Lesn Loaded / Lesn Not Loaded.    If 

no Lesn has been loaded by Opening or Creating a new Lesn, the user is in Start domain.    A 
Lesn must be loaded to be In any other domain.
Changing Domains

After filling in the domain information, Talking BookMakr users "Continue" -- move 
forward, to fill in the next domain item.    Fourteen of the domains are involved in the ongoing 
process of making a Lesn.    Go to the next domain by clicking most places on the screen with 
the RIGHT mouse button which has the same effect as clicking the Continue Icon, .    The Green
Continue Icon / Right mouse click to Continue is the most important thing to remember to create
a Tallking Book Lesn.    The red Previous Icon, , has the oposite effect, moving the user 
backward to a previous domain.

Opening, Creating or Exiting a Lesn automatically moves the user between Start and 
Title domain.
The domain may also be changed by clicking on it in the Domain List Box or the Domain 
Diagram.    If a domain is selected on another page, the page will change as well as the domain.
Changing Pages

Changing Pages automatically changes the domain.



Index of Icons
Icon Name

Automatic Video
Choice
Choices
Continue
Create Text
Edit Words
Exit
Font
Font Color
Font Size
Font Style
Manual Video Control
New
Previous
Print
Question
Question Page 
(QPage)
Re-align Words
Read Words
Record
Response
Select Picture
Select Sound
Select Video
Stop Recording
View Picture
View Sound
View Video



Moves to the next record in the Lesn database.



Shorter
Decrease the size of the sound segment to be played by one twenty-fifth of the number of 
milliseconds in the increment display, and read the sound file segment.    Decreases by a small 
amount - used for fine tuning.



Longer
Increase the sound segment to be played by one twenty-fifth of the number of milliseconds in 
the increment display, and read the sound file segment.    Increases by a small amount - used 
for fine tuning.



Score Window 
The window on the right side of the Repeat button, which shows the student's score (Sum of 
values of questions correct / questions answered * 100).    Answering the same question twice 
counts as two answers.



Edit-Cut
Deletes user-selected text from the document and saves it in the Windows Clipboard.



Edit-Paste
Pastes text residing in the MS-Windows clipboard into the document at the user-selected 
location.



Edit-Copy
Copies user-selected text in the document to the Windows Clipboard.



Picture
The picture is usually the main part of the Reading page.    The text usually talks about the 
picture.



Selecting a Word
A word is selected when it is enclosed in a dotted-line box.    When the word is selected, it is the 
current word, and the current object.
1.    Enter the Words domain
2.    Click on the word OR
3.    Hold down the    key while pressing the (right arrow key) to move the selection to the next 
word OR
4.    Hold down the    key while pressing the (left arrow key) to move the selection to the previous
word 



Domain
An activity in which the user supplies one or more pieces of information.    In the Title Domain, 
the user inputs the Title of the Lesn, the font attributes, size, style, color & typeface of the Title 
and the sound file which plays when the Title is presented.



Directory Structure
If the directory in which you install Talking BookMakr is C:\LESN, then the directory structure is:

C:\Lesn Programs, DLL's, Database
C\Lesn\Lesns Master Directory for Lesns



How To Highlight Multi-Word Groups
Users may wish to highlight multiple words in a sentence.    For example, in the sentence, "The 
flying dinosaur swooped down.", we want the words "flying dinosaur" to highlight together.
1.      Get into Text domain.
2.      Type in the sentence but with only the first word of the desired phrase:
              "The flying swooped down."
3.      Continue to Word domain by clicking the .
4.      Select the word "flying" by clicking on it.
5.      Use the arrow keys to move to the last letter in the word ("g").
6.      Type dinosaur.
7.      Click the    to re-align the words and make the word window big enough for both words.    
Talking BookMakr now considers the phrase, "flying dinosaur" to be one word.
8.      Continue to Text Sound domain by clicking the .
9.      Record the sentence.
10. Continue to Synchro domain by clicking the .
11. When the Synchro controller gets to the phrase, "flying dinosaur", synchronize the sound to 
read both words.    Complete the rest of the synchronization as usual, and continue with making 
the Talking Book.






